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஧ாைம் 1 . கணி஦ி அ஫ிப௃கம் 
சரினா஦ யிலைலனமதர்ந்ததடுத்து எழுதுக: 

1. ன௅தல் தல஬ன௅ல஫ கணிப்ப஧ொ஫ிக஭ில் ஧னன்஧டுத்தப்஧ட்ட ஧குதிப்ப஧ொன௉ள்  
(அ) தயற்஫ிைக் குமல்   (ஆ) திரிதலடனகம்  
(இ) என௉ங்கிலணந்தச் சுற்றுகள்  (ஈ) நுண்பென஬ிகள் 

2. தற்கொ஬ிக ஥ில஦யகம் ஋து?  
(அ) ROM  (ஆ) PROM  (இ) RAM  (ஈ) EPROM 

3. பய஭ினடீ்டு ெொத஦த்லத அலடனொ஭ம் கொண்க.  
(அ) யிலெப்஧஬லக  (ஆ) ஥ில஦யகம்  (இ) திலபனகம்  (ஈ) சுட்டி 

4. உள்஭டீ்டு ெொத஦த்லத அலடனொ஭ம் கொண்க 
(அ) அச்சுப்ப஧ொ஫ி  (ஆ) சுட்டி   (இ) யலபயி   (ஈ) ஧டயழீ்த்தி  

5. கட்டிட யலப஧டத் திட்டம், ஧ி஭க்ஸ் அட்லட ப஧ொன்஫யற்ல஫ அச்ெிடப் ஧னன்஧டும் 
பய஭ினடீ்டு ெொத஦ம் ஋து?  
(அ) பயப்஧அச்சுப்ப஧ொ஫ி   (ஆ) யலபயி  
(இ) ன௃ள்஭ி அச்சுப்ப஧ொ஫ி   (ஈ) லந஧சீ்சு அச்சுப்ப஧ொ஫ி  

6. ஌.டி.஋ம் இனந்திபங்க஭ில், கீழ்க்கண்டயற்றுள் ஋து ஧னன்஧டுத்தப்஧டுகி஫து?  
(அ) ததாடுதிலப  (ஆ) திலபனகம்  (இ) எ஬ி ப஧ன௉க்கி  (ஈ) அச்சுப்ப஧ொ஫ி 

7. என௉ கணிப்ப஧ொ஫ி நீண்டும் பதொடங்கும் ப஧ொது ஋ந்த யலகனொ஦ 
பதொடங்குதல஬ப் ஧னன்஧டுத்துகி஫து.  
(அ) உைன் ததாைக்கம்   (ஆ) தண் பதொடக்கம்  
(இ) பதொடு பதொடக்கம்   (ஈ) பநய் பதொடக்கம் 

8. POST – ன் யிரியொக்கம்.  
(அ) Post on self Test   (ஆ) Power on Software Test  
(இ) Power on Self Test  (ஈ) Power on Self Text 

9. கீழ்யன௉ய஦யற்றுள் ஋து என௉ ன௅தன்லந ஥ில஦யகநொகும்?  
(அ) ROM   (ஆ) RAM  (இ) Flash drive  (ஈ) Hard disk 

10. ஋ந்த கணிப்ப஧ொ஫ி தல஬ன௅ல஫னில் என௉ங்கிலணந்தசுற்றுகள் 
஧னன்஧டுத்தப்஧ட்டது?  
(அ) ன௅த஬ொம்  (ஆ) இபண்டொம் (இ) ப௄ன்஫ாம் (ஈ) ஥ொன்கொம் 
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ி என்஫ால் என்஦ ? 

 கணிப்ப஧ொ஫ி ஋ன்஧து, பகொடுக்கப்஧ட்ட கட்டல஭கல஭ உள்஭டீொகப் ப஧ற்று, 
அதிபயகநொகச் பெனல்஧ட்டு, யின௉ம்஧ின பய஭ினடீ்லட யமங்கும் என௉ 
நின்஦ணு ெொத஦ம் ஆகும். 

2. தபவு நற்றும் தகயல் மயறு஧டுத்துக. 
தபவு தகயல் 

஧ல்பயறு யலகக஭ிலும் திபட்டப்஧டும் 
பெனற்஧டுத்தப்஧டொத அடிப்஧லட 
பெய்தித் துணுக்கு தபவு ஋஦ப்஧டும். 

தகயல் ஋ன்஧து ன௅டிவுகல஭ 
஋டுக்கக்கூடின உண்லநக஭ின் 
பதொகுப்஧ொகும். 

(஋.கொ) அன௉ண், 16 (஋.கொ) அன௉ணின் யனது 16 
3. லநனச்தசன஬கத்தின் (CPU) ஧குதிகள் னாலய? 

 லநனச்பென஬கத்தில் னென்று ஧குதிகள் உள்஭஦, அலய  
1. கட்டுப்஧ொட்டகம் (CU - ControlUnit),  
2. கணித ஌பணச் பென஬கம் (ALU - Arithmetic and Logic Unit) நற்றும்  
3. ஥ில஦யகம் (MU - Memory Unit) ஆகும்.  

4. கணித ஏபண தசன஬கத்தின் (ALU) தசனல்஧ாடு னாது? 

 லநனச்பென஬கத்தின் என௉ ஧குதினொக உள்஭ கணித ஌பணச் பென஬கம், 
கூட்டல், கமித்தல், ப஧ன௉க்கல், யகுத்தல் நற்றும் தன௉க்க பெனல்கள் ப஧ொன்஫ 
கணிதச் பெனல்஧ொடுகல஭க் தபயின் நீது ஥ிகழ்த்துகி஫து. 

5. கட்டுப்஧ாட்ைகத்தின் தசனல்கல஭ எழுதுக. 
 லநனச்பென஬கம் - ஥ில஦யகம் நற்றும் உள்஭டீு பய஭ினடீு ெொத஦ங்கல௃க்கு 

இலடபன ஧ரிநொ஫ப்஧டும் தபலயக் கட்டுப்஧ொட்டகம் கட்டுப்஧டுத்துகி஫து. பநலும், 
கணிப்ப஧ொ஫ினின் ன௅ழுச் பெனல்஧ொடுகல஭னேம் இது கட்டுப்஧டுத்துகி஫து. 

6. ஥ில஦யகத்தின் தசனல்஧ாடு னாது? 
 ஥ில஦யகம், பென஬ொக்கத்தின் ப஧ொது தபவு நற்றும் கட்டல஭கல஭ 

தற்கொ஬ிகநொக பெநித்து லயக்கி஫து. 
7. உள்஭டீ்ைகம் நற்றும் தய஭ினீட்ைகம் மயறு஧டுத்துக. 

உள்஭டீ்ைகம் தய஭ினீட்ைகம் 
அல஦த்து யலகனொ஦ தபவுகல஭னேம் 
கணிப்ப஧ொ஫ிக்குள் உள்஭ிடப் 
஧னன்஧டுகி஫து. உள்஭ிடப்஧ட்ட தபவுகள் 
பென஬ொக்கத்திற்கொக ஥ில஦யகத்தில் 
பெநிக்கப்஧டுகின்஫஦.  
஋.கொ: யிலெப்஧஬லக, சுட்டி ப஧ொன்஫லய. 

஧ன஦ர்கள் ன௃ரிந்து பகொள்஭க்கூடின 
யலகனில் தகயல஬த் பதரியிக்கும் 
஋ந்தபயொன௉ யன்ப஧ொன௉ல௃ம் பய஭ினடீ்டகம் 
஋஦ப்஧டும். 
஋.கொ: திலபனகம், அச்சுப்ப஧ொ஫ி 
ப஧ொன்஫லய. 

8. ப௃தன்லந ஥ில஦யகம் நற்றும் இபண்ைாம் ஥ில஬ ஥ில஦யகம் மயறு஧ாடு னாது? 

ப௃தன்லந ஥ில஦யகம் இபண்ைாம் ஥ில஬ ஥ில஦யகம் 

கட்டல஭கள் ஥ில஫பயற்஫த் தனொபொக 
இன௉க்கும் ப஧ொது தபவு நற்றும் 
஥ிபல்கல஭த் தற்கொ஬ிகநொகச் பெநிக்க 
ன௅தன்லந ஥ில஦யகம் ஧னன்஧டுகி஫து.  
஋.கொ: ப஥படி அணுகல் ஥ில஦யகம் 
(RAM - Random Access Memory) 

தபவுகல஭ ஥ிபந்தபநொகச் பெநித்து லயக்க 
இபண்டொம் ஥ில஬ ஥ில஦யகம் 
஧னன்஧டுகி஫து. 
஋.கொ: யன் யட்டு (Hard disk), குறுயட்டு 
(CD-ROM) நற்றும் டியிடி பபொம் (DVD ROM) 
ப஧ொன்஫லய. 
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3 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ினின் தன்லநகள் னாலய? 

 பயகம்  *  ஧ிலமனின்லந   *  ஥ில஦யகத்தி஫ன்  
 துல்஬ினம் *  பெொர்யின்லந  *    ஧ல்யலக பென஬ொக்கத்தி஫ன் 

2. கணிப்த஧ா஫ினின் ஧னன்஧ாடுகல஭ எழுதுக. 
 கணிப்ப஧ொ஫ிகள் தபவுகல஭ச் பெநிக்க ஧னன்஧டுகி஫து. 

 கல்யி, ஆபொய்ச்ெி, சுற்று஬ொ, ெனெக யல஬த஭ம், நின் யணிகம் ப஧ொன்஫ ஧ல்பயறு 

துல஫க஭ில் கணிப்ப஧ொ஫ிகள் ஥ீங்கொ இடம் ப஧ற்றுள்஭஦. 

 யொ஦ில஬ ன௅ன்஦஫ியிப்ன௃, யிநொ஦ம், பனில் ப஧ொக்குயபத்து ஧னணச்ெீடடு 

ன௅ன்஧திவு, திலபனபங்கு நுலமவுச்ெீடடு ன௅ன்஧திவு  ப஧ொன்஫ ஧஬ ஧ணிகல஭னேம், 

யில஭னொடடு நற்றும் இதப ப஧ொழுதுப஧ொக்கு அம்ெங்கல஭னேம் பெய்னேம் ஧ல்தி஫ன் 

ப஧ற்஫லயனொக உள்஭து. 

3. உள்஭டீ்டு சாத஦ங்கள் என்஫ால் என்஦? இபண்டு எடுத்துக்காட்டுகள் 
தருக. 
 அல஦த்து யலகனொ஦ தபவுகல஭னேம் கணிப்ப஧ொ஫ிக்குள் உள்஭ிட 

஧னன்஧டுத்தும் ெொத஦ங்கள் உள்஭டீ்டுச் ெொத஦ங்கள் ஋஦ப்஧டும். 
஋.கொ: Éir¥gyif, R£o. 

4. ஏமதனும் ப௄ன்று தய஭ினீட்டு சாத஦ங்கல஭ யி஭க்குக. 

 அச்சுப்த஧ா஫ிகள்: தொள்க஭ில் தகயல்கல஭ அச்ெிட  ஧னன்஧டுத்தப்஧டுகி஫து.  
யலககள்: தட்டல் அச்சுப்ப஧ொ஫ிகள், தட்டொ அச்சுப்ப஧ொ஫ிகள்  

 யலபயி: தொள்க஭ில் யலபகல஬ பய஭ினடீ்லட அச்ெிட ஧னன்஧டுகி஫து. இது 
஧டங்கல஭ யலபன எற்ல஫ ஥ி஫ம் அல்஬து ஧஬ யண்ணம் பகொண்ட 
ப஧஦ொக்கல஭ ஧னன்஧டுத்துகி஫து. 

 ஧ல்லூைகப்஧ையழீ்த்தி: கணிப்ப஧ொ஫ி திலபனக பய஭ினடீ்லடப் ப஧ரின 
திலபனில் திலபனிடப் ஧னன்஧டுகின்஫து. இலயகள் யகுப்஧ல஫க஭ில் அல்஬து 
கூட்ட அபங்குக஭ில் யி஭க்கக் கொட்ெிகல஭க் கொட்ெிப்஧டுத்தப் 
஧னன்஧டுத்தப்஧டுகின்஫஦. 

5. ஒ஭ினினல் சுட்டி நற்றும் ம஬சர் சுட்டி மயறு஧டுத்துக. 
ஒ஭ினினல் சுட்டி ம஬சர் சுட்டி 

சுட்டி ஥கர்யலத தீர்நொ஦ிக்க எ஭ி 
஧னன்஧டுத்தப்஧டுகி஫து. 

அகச்ெியப்ன௃ கதிர்கல஭ 

஧னன்஧டுத்துகி஫து. 

இதில் னென்று ப஧ொத்தொன்கள் உள்஭஦. அதிக஭யொக 12 ப஧ொத்தொன்கள் யலப 

இன௉க்கும். 

குல஫யொ஦ உணர்தி஫ன் பகொண்டது. நிகுந்த உணர்தி஫ன் பகொண்டது. ஋ந்த 

கடி஦நொ஦ பநற்஧பப்஧ிலும் பெனல்஧டும். 

6. தட்ைல்யலக அச்சுப்த஧ா஫ிலனப் ஧ற்஫ி கு஫ிப்பு யலபக. 

 தட்டல்யலக அச்சுப்ப஧ொ஫ினில் என௉ ெிறு கம்஧ி, லந நாடா (ribbon) நீது தட்டி என௉ 

ன௃ள்஭ிலன ஌ற்஧டுத்தும் அல்஬து என௉ ன௅ழு ஋ழுத்லத தட்டி அந்த ஋ழுத்லத 
஌ற்஧டுத்தும்.  

 இந்த அச்சுப்ப஧ொ஫ிகள் இனந்திப அழுத்தத்லதப் ஧னன்஧டுத்தி எபப ெநனத்தில் ஧஬ 
஧டிகள் ஋டுக்க யலக பெய்கி஫து.  

எ.கா: யரி அச்சுப்ப஧ொ஫ி நற்றும் யரின௃ள்஭ி அச்சுப்ப஧ொ஫ி  
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7. ஆ஫ாயது தல஬ப௃ல஫னின் தன்லநகல஭ ஧ற்஫ி சிறு கு஫ிப்பு யலபக. 
 பெனற்லக ஥பம்஧ினல் யல஬னலநப்஧ின் அடிப்஧லடனில் ஆ஫ொயது 

தல஬ன௅ல஫ கணிப்ப஧ொ஫ிகள், அ஫ிவு ெொர்ந்த கணிப்ப஧ொ஫ிகள் ஋஦ 
யலபனறுக்கப்஧டுகி஫து.  

 ஆ஫ொயது தல஬ன௅ல஫ கணிப்ப஧ொ஫ிக஭ின் யினத்தகு நொற்஫ங்க஭ில் என்று 
஧பந்த யல஬னலநப்஧ின் ய஭ர்ச்ெி ஆகும்.  

 இனற்லக பநொமி பென஬ொக்கம் ஋ன்஧து பெனற்லக நுண்ண஫ியின் என௉ 
அங்கநொகும். இது ந஦ித பநொமிலனப் ன௃ரிந்து பகொள்஭க் கூடின என௉ 
கணிப்ப஧ொ஫ி ஥ிபல஬ உன௉யொக்குயதற்கொ஦ தி஫ல஦ யமங்குகி஫து. 

8. திலபனகத்தின் கு஫ிப்஧ிைத்தக்க சி஫ப்஧ினல்புகல஭ ஧ற்஫ி எழுதுக. 
 தகயல஬ திலபனில் கொட்ட ப஧ொதுயொகப் ஧னன்஧டுத்தப்஧டும் பய஭ினடீ்டு 

ெொத஦ம் திலபனகம் ஆகும். இது பதொல஬க்கொட்ெி ப஧ட்டிலனப் ப஧ொன்஫து.  
 திலபனகத்தில் ஧டங்கள் ஧ிக்பெல்ஸ் (PIXELS) ஋஦ப்஧டும் ஧டக் கூறுகல௃டன் 

உன௉யொக்கப்஧டுகின்஫஦.  
 எபப யண்ணன௅லடன திலபனகம் கன௉ப்ன௃ நற்றும் பயள்ல஭ ஥ி஫த்தில் 

கொட்டுகி஫து. யண்ணத் திலபனகம் ஧஬ ஥ி஫ங்க஭ில் கொட்டுகி஫து.  
 திலபனகம் தகயல஬ யிஜி஌ -VGA (Video Graphics Array) னெ஬ம் திலபனில் 

கொட்டுகி஫து. 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஒரு கணிப்த஧ா஫ினின் அடிப்஧லை ஧ாகங்கல஭ தத஭ியா஦ 

யி஭க்கப்஧ைத்துைன் யி஭க்குக. 
 கணிப்ப஧ொ஫ினில், பகொடுக்கப்஧ட்ட எவ்பயொன௉ ஧ணினேம், உள்஭டீு- 

பென஬ொக்கம்-பய஭ினடீு ஋ன்஫ சுமற்ெிலன அடிப்஧லடனொகக் பகொண்டு 
பென஬ொற்றுகி஫து. 

 
 உள்஭டீ்ைகம்: அல஦த்து யலகனொ஦ தபவுகல஭னேம் கணிப்ப஧ொ஫ிக்குள் உள்஭ிடப் 

஧னன்஧டுகி஫து. உள்஭ிடப்஧ட்ட தபவுகள் பென஬ொக்கத்திற்கொக ஥ில஦யகத்தில் 
பெநிக்கப்஧டுகின்஫஦.  
எ.கா: யிலசப்஧஬லக, சுட்டி ம஧ான்஫லய . 

 லநனச்தசன஬கம்: லநனச்பென஬கம் ஋ன்஧து, கணிப்ப஧ொ஫ிக்கு யமங்கப்஧டும் 
கட்டல஭கல஭க், கணிப்ப஧ொ஫ி ன௃ரிந்துபகொள்ல௃ம் யலகனில் நொற்஫ி அதல஦ 
பென஬ொக்கம் பெய்னேம் ன௅தன்லநனொ஦ ஧குதினொகும். 
லநனச்தசன஬கத்தில் ப௄ன்று ஧குதிகள் உள்஭஦, அலய  

 கட்டுப்஧ொட்டகம் (CU - ControlUnit),  
 கணித ஌பணச் பென஬கம் (ALU - Arithmetic and Logic Unit) நற்றும்  
 ஥ில஦யகம் (MU - Memory Unit) ஆகும்.  

 ஥ில஦யகம்: ன௅தன்லந ஥ில஦யகம் நற்றும் இபண்டொம் ஥ில஬ ஥ில஦யகம் ஋஦ 
இன௉யலக ஥ில஦யகங்கள் உள்஭஦. 

o கட்டல஭கள் ஥ில஫பயற்஫த் தனொபொக இன௉க்கும் ப஧ொது தபவு நற்றும் 
஥ிபல்கல஭த் தற்கொ஬ிகநொகச் பெநிக்க ன௅தன்லந ஥ில஦யகம் 
஧னன்஧டுகி஫து.  
஋.கொ: ப஥படி அணுகல் ஥ில஦யகம் (RAM - Random Access Memory) 

o தபவுகல஭ ஥ிபந்தபநொகச் பெநித்து லயக்க இபண்டொம் ஥ில஬ ஥ில஦யகம் 
஧னன்஧டுகி஫து.  
஋.கொ: யன்யட்டு (Hard disk), குறுயட்டு (CD-ROM) நற்றும் டியிடி பபொம் (DVD 
ROM) ப஧ொன்஫லய. 

 தய஭ினீட்ைகம்: ஧ன஦ர்கள் ன௃ரிந்து பகொள்஭க்கூடின யலகனில் தகயல஬த் 
பதரியிக்கும் ஋ந்தபயொன௉ யன்ப஧ொன௉ல௃ம் பய஭ினடீ்டகம் ஋஦ப்஧டும். 
஋.கொ: திலபனகம், அச்சுப்ப஧ொ஫ி ப஧ொன்஫லய. 
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2. கணிப்த஧ா஫ினின் ஧ல்மயறு தல஬ப௃ல஫கல஭ யி஭க்குக. 

கணிப்ப஧ொ஫ினின் ய஭ர்ச்ெிலனப் ஧ல்பயறு ஥ில஬க஭ின் அடிப்஧லடனில் ஆறு 
தல஬ன௅ல஫க஭ொகப் ஧ிரிக்க஬ொம். 

தல஬ப௃ல஫ கா஬ம் 
஧னன்஧டுத்தின 

சாத஦ம் 
஥ில஫/ குல஫ 

ன௅த஬ொம் 
தல஬ன௅ல஫ 

(1940-1956) பயற்஫ிடக் 
குமல்கள்  

 அ஭யில் ப஧ரினது. அதிக அ஭வு 
நின்ெொபத்லத ஋டுத்துக்பகொண்டது. 

 இனந்திப பநொமி 
஧னன்஧டுத்தப்஧ட்டது. 

ன௅தல் தல஬ன௅ல஫ கணிப்ப஧ொ஫ிகள் - ENIAC , EDVAC , UNIVAC 1 
இபண்டொம் 
தல஬ன௅ல஫ 

(1956-1964) திரிதலடனங்கள்   அ஭யில் ெி஫ினது. 
 குல஫ந்த நின்ெொபத்லத 

஋டுத்துக்பகொண்டது. 
 ன௅தல் இனக்கஅலநப்ன௃  

உன௉யொக்கப்஧ட்டது. 
 இனந்திப பநொமி நற்றும் அபெம்஧஭ி 

பநொமி ஧னன்஧டுத்தப்஧ட்டது. 

இபண்டொம் தல஬ன௅ல஫ கணிப்ப஧ொ஫ிகள் - IBM 1401, IBM 1620, UNIVAC 1108 
னென்஫ொம் 
தல஬ன௅ல஫ 

(1964-1971) என௉ங்கிலணந்த 
சுற்றுகள்  

 கணிப்ப஧ொ஫ிகள் யிலபயொக 
பெனல்஧டும் நற்றும் அதிக ஥ம்஧கத் 
தன்லநனேலடனது. 

 உனர்஥ில஬ பநொமி 
஧னன்஧டுத்தப்஧ட்டது. 

னென்஫ொம் தல஬ன௅ல஫ கணிப்ப஧ொ஫ிகள் - IBM 360 series, Honeywell 6000 series 
஥ொன்கொம் 
தல஬ன௅ல஫ 

(1971-1980) நுண் பென஬ி  ெி஫ினது நற்றும் பயகநொ஦து. 
 IBM நற்றும் APPLE ப஧ொன்஫ நுண் 

கணிப்ப஧ொ஫ிகள் உன௉யொக்கப்஧ட்டது. 
 லகனடக்க கணிப்ப஧ொ஫ிகள் 

அ஫ின௅க஧டுத்தப்஧ட்டது. 
஍ந்தொம் 
தல஬ன௅ல஫ 

1980 - 
இன்றுயலப 

நீப்ப஧ன௉ 
அ஭யி஬ொ஦ 
என௉ங்கிலணந்த 
சுற்றுகள் 

 இலண பென஬ொக்கம்.  
 ஥ிமற்஧டங்கள் நற்றும் 

யலப஧டங்கல஭ப் ன௃ரிந்து பகொள்ல௃ம் 
தி஫ன்.  

 பெனற்லக நுண்ண஫ிவு நற்றும் 
஥ின௃ணர் அலநப்ன௃ அ஫ின௅கம். 

ஆ஫ொயது 
தல஬ன௅ல஫ 

஋திர் 
கொ஬த்தில் 
 

  இலண நற்றும் ஧கிர்வு கணிப்஧டீு. 
 கணிப்ப஧ொ஫ிகள் தி஫லநனொகவும், 

யிலபயொகவும் நற்றும் 
ெி஫ினதொகவும் இன௉க்கும். 

 பெனற்லக ந஦ிதர்கள் (Robots) 
உன௉யொக்குதல். 
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3. ஧ின்யருய஦யற்ல஫ யி஭க்குக. 
அ) லந஧ீச்சு அச்சுப்த஧ா஫ி,  
ஆ) ஧ல்லூைக ஧ையழீ்த்தி,  
இ) ஧ட்லைக் கு஫ினீடு / QR கு஫ினீடு ஧டிப்஧ான் 

 

அ) லந஧ீச்சு அச்சுப்த஧ா஫ி:  
 லந஧சீ்சு அச்சுப்ப஧ொ஫ிகள் கன௉ஞ்ெியப்ன௃, நஞ்ெள் நற்றும் ெினொன் உள்஭டக்கின 

லநகுப்஧ிலனப் ஧னன்஧டுத்தி யண்ண ெொனல஬  உன௉யொக்குகி஫து. என௉ ஥ி஫ 
யண்ணத்தில் அச்ெிடுயதற்கு கன௉ப்ன௃ லநகுப்஧ிலன ஧னன்஧டுத்துகி஫து.  

 லநப்஧சீ்சு அச்சுப்ப஧ொ஫ிகள் என௉ கொகிதத் தொ஭ில் நின்னூட்டம் 
ப஧ற்஫லநலனத் பத஭ிப்஧தன் னெ஬ம் பெனல்஧டுகி஫து.  

 இதன் அச்ெிடும் பயகம் ப஧ொதுயொக என௉ ஥ிநிடத்திற்கு 1 ன௅தல் 20 
஧க்கங்கல஭ அச்ெிடும்  

ஆ) ஧ல்லூைக ஧ையழீ்த்தி: 
 கணிப்ப஧ொ஫ி திலபனக பய஭ினடீ்லடப் ப஧ரின திலபனில் திலபனிடப் 

஧னன்஧டுகின்஫து.  
 இலயகள் யகுப்஧ல஫க஭ில் அல்஬து கூட்ட அபங்குக஭ில் யி஭க்கக் 

கொட்ெிகல஭க் கொட்ெிப்஧டுத்தப் ஧னன்஧டுத்தப்஧டுகின்஫஦. 
இ) ஧ட்லைக் கு஫ினீடு / QR கு஫ினீடு ஧டிப்஧ான்: 

 ஧ட்லடக்கு஫ினடீு ஋ன்஧து பயவ்பயறு தடிநன் யரிலெனில் அச்ெிடப்஧டும் என௉ 

யடியம் ஆகும்.  

 ஧ட்லடக் கு஫ினடீ்டு ஧டிப்஧ொன், ஧ட்லடக் கு஫ினடீ்லடப் ஧டித்து அயற்ல஫ நின் 

துடிப்ன௃க஭ொக நொற்஫ி கணிப்ப஧ொ஫ி பென஬கத்திற்கு அனு஧ன௃ம் என௉ 

கன௉யினொகும்.  
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஧ாைம் 2. எண் ப௃ல஫கள் 

சரினா஦ யிலைலனமதர்ந்ததடுத்து எழுதுக: 
1. கணிப்ப஧ொ஫ினின் லநனச் பென஬கத்தில் ஧ிட்டுக஭ின் ஋ண்ணிக்லக ஋வ்யொறு 

கு஫ிப்஧ிடப்஧டுகி஫து?  
(அ) ல஧ட்  (ஆ) ஥ி஧ில்   (இ) மயர்டு ஥ீ஭ம்   (ஈ) ஧ிட் 

2. என௉ கிப஬ொ ல஧ட் ஋ன்஧து ஋த்தல஦ ல஧ட்டுகல஭க் பகொண்டது?  
(அ) 1000  (ஆ) 8  (இ) 4   (ஈ) 1024 

3. ASCII ஋ன்஧தன் யிரியொக்கம்:  
(அ) American School Code for Information Interchange  
(ஆ) American Standard Code for Information Interchange  
(இ) All Standard Code for Information Interchange  
(ஈ) American Society Code of Information Interchange 

4. 2^50 ஋ன்஧து ஋லத கு஫ிக்கும்?  
(அ) கிப஬ொ (Kilo)  (ஆ) படபொ(Tera)  (இ) ஧ீட்ைா(Peta)  (ஈ) ஜடீ்டொ(Zetta) 

5. Binary Coded Decimal ன௅ல஫னில் ஋த்தல஦ ஋ழுத்துன௉க்கல஭க் லகனொ஭ ன௅டினேம்?  
(அ) 64  (ஆ) 255  (இ) 256  (ஈ) 128 

6. 11012-க்கு ஥ிகபொ஦ ஧தி஦ொறு஥ில஬ நதிப்ன௃ ஋து?  
(அ) F   (ஆ) E  (இ) D   (ஈ) B 

7. 00100110 க்கொ஦ 1-ன் ஥ிபப்஧ி ஋து?  
(அ) 00100110   (ஆ) 11011001   (இ) 11010001   (ஈ) 00101001 

8. கீழ்க்கண்டயற்஫ில் ஋து ஋ண்ணில஬ ஋ண் அல்஬?  
(அ) 645  (ஆ) 234  (இ) 876  (ஈ) 123 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

அ஬கு I - கணி஦ி அ஫ிப௃கம்  
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. தபவு என்஫ா ல் என்஦ ? 

 தபவு ஋ன்஧தற்கொ஦ ஆங்கி஬ யொர்த்லதனொ஦ Data ஋ன்஫ பெொல் Datum ஋ன்஫ 
பெொல்஬ி஬ின௉ந்து யந்தது. அதன் ப஧ொன௉ள் "பெனல்஧டுத்தப்஧டொத னெ஬ தகயல்" 
஋ன்஧தொகும்.  

 தபவு ஋ன்஧து நக்கள், இடங்கள் அல்஬து ப஧ொன௉ட்க஭ின் ஧஬ தகயல்கல஭ 
பகொண்டது. 

2. 1-ன் ஥ிபப்பு ப௃ல஫ க்கா஦ யமிப௃ல஫ கல஭ எழுதுக. 

 பகொடுக்கப்஧ட்ட ஧தின்ந ஋ண்ணுக்கு ஥ிகபொ஦ இன௉஥ில஬ ஋ண்ணொக நொற்஫ 
பயண்டும். 

 நொற்஫ப்஧ட்ட இன௉஥ில஬ ஋ண் 8 ஧ிட்டுக஭ொக உள்஭தொ ஋ன்஧லதச் ெரி஧ொர்த்து,  
8 ஧ிட்டுக்கும் குல஫யொக இன௉ப்஧ின், ன௅ன்ப஦ொட்டொக 0-க்கல஭ச் பெர்த்து      
8 ஧ிட்டுக஭ொக நொற்஫ பயண்டும். 

 அல஦த்து ஧ிட்டுகல஭னேம், தல஬கீமொக நொற்஫ பயண்டும். அதொயது 1 
஋ன்஧லத 0 ஋஦வும், 0 ஋ன்஧லத 1 ஋஦வும் நொற்஫ பயண்டும். 

3. (46)10க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணா க நாற் றுக. 

2   46 

2   23 – 0 

2   11 – 1 

2    5 – 1 

2    2 – 1 

     1 – 0 
 

 

(46)10 = 1011102 

4. (28)10 க்கு 1-ன் ஥ிபப்பு ப௃ல஫ னில் யிலை காண ப௃டினாது. ஏன் காபணம் கூறு. 

 (28)10 க்கு 1-ன் ஥ிபப்ன௃ ன௅ல஫ னில் யிலட கொண ன௅டினொது. 

 1 – ன் ஥ிபப்ன௃ ன௅ல஫னொ஦து ஋திர்நல஫ ஋ண்கல௃க்கு நட்டுபந ப஧ொன௉ந்தும். 

5. எழுத்துருக்கல஭ ஥ில஦யகத்தில் லக னால௃யதற்கா஦ கு஫ினீட்டு ப௃ல஫ 

கல஭ப் ஧ட்டின஬ிடுக. 

 ASCII 

 BCD 

 EBCDIC 

 ISCII 

 Unicode 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. எண் ப௃ல஫னில் அடிநா஦ம் என்஫ால் என்஦ ? எடுத்துக்காட்டு தருக. 

 அடிநொ஦ம் ஋ன்஧து எவ்பயொன௉ ஋ண்ன௅ல஫னிலும் உள்஭ பநொத்த ஋ண் 
உன௉க்க஭ின் ஋ண்ணிக்லகலனக் கு஫ிக்கும். 

 எவ்பயொன௉ ஋ண் ன௅ல஫னேம், அதன் அடிநொ஦ நதிப்ல஧ பகொண்டு அலடனொ஭ம் 
கொணப்஧டும். 
எ.கா: இன௉஥ில஬ ஋ண் ன௅ல஫னில் 0 நற்றும் 1 ஋ன்஫ இபண்டு ஋ண் உன௉க்கள் 
நட்டுபந உள்஭தொல் அதன் அடிநொ஦ம் – 2, ஧தின்ந ஋ண் 0 ன௅தல் 9 யலப 
பநொத்தம் 10 ஋ண் உன௉க்கல஭ பகொண்டுள்஭து. ஋஦பய, இதன் அடிநொ஦ம் – 10. 
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2. இரு஥ில஬ எண் ப௃ல஫ – கு஫ிப்பு யலபக. 
 இன௉஥ில஬ ஋ண் ன௅ல஫னில் 0 நற்றும் 1 ஋ன்஫ இபண்டு ஋ண் உன௉க்கள் 

நட்டுபந உள்஭து. இந்த ன௅ல஫ , 2 லன அடிநொ஦நொகக் பகொண்டுள்஭து.  
 என௉ இன௉஥ில஬ ஋ண் பதொடரின் இடது ஏப ஧ிட், அதிக ஥ில஬ ஥ில஫ நதிப்ல஧ 

பகொண்டுள்஭தொல், அது “நிகு நதிப்ன௃ ஧ிட்” (Most Significant Bit – MSB) ஋஦வும், 
ய஬து ஏப ஧ிட் குல஫ந்த நதிப்ல஧ப் ப஧றுயதொல், அது “குல஫ நதிப்ன௃ ஧ிட்” 
(Least Significant Bit – LSB) ஋஦வும் அலமக்கப்஧டுகின்஫து. 
 

3. (150)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணாக நாற்஫ி, அதல஦ எண்ணில஬ 
எண்ணாக நாற்றுக. 
15010 f;F epfuhd ,Uepiy vz;: 

2   150 

2    75    – 0 

2    37    – 1 

2    18    – 1 

2     9     – 0 

2     4     – 1 

2     2     – 0 

      1      – 0 
 

15010 = 100101102 

15010 f;F epfuhd vz;zpiy vz;: 

 பகொடுக்கப்஧ட்ட இன௉஥ில஬ ஋ண்கல஭ ய஬நின௉ந்து இடநொக னென்று ஧ிட்டுக஭ொக 

குழுயொக்கவும். இடது ஏப குழு னென்று ஧ிட்டுக஭ொக அலநனயில்ல஬ ஋஦ில் 
அதல஦ னென்று ஧ிட்டொக நொற்஫ 0 ன௅ன்ப஦ொட்டொக பெர்க்க பயண்டும்.  

 எவ்பயொன௉ குழுயிலும் உள்஭ இன௉஥ில஬ நதிப்ன௃க்கல௃க்கு ஥ிகபொ஦ ஧தின்ந 
஋ண்கல஭ கணக்கிட பயண்டும். 

010  010  110 

  2     2     6 

15010 = 2268  

4. ISCII கு஫ிப்பு யலபக. 

 இந்தின பநொமிக஭ின் ஧ல்பயறு ஋ழுத்துன௉க்கல஭ நட்டும் லகனொல௃ம் 
ப஥ொக்கில் யடியலநக்கப்஧ட்ட ஏர் ன௅ல஫ ISCII ஆகும்.  

 இது 8 ஧ிட் கு஫ினடீ்டு ன௅ல஫னொகும். ஋஦பய, இந்த ன௅ல஫னில் 256 
஋ழுத்துன௉க்கல஭க் லகனொ஭ ன௅டினேம். 

 இந்தின அபெின் நின்஦ணு துல஫னொல் 1986-88 ஆண்டுயொக்கில் இந்த ன௅ல஫ 
உன௉யொக்கப்஧ட்டு, இந்தின தப஥ிர்ணனக் குழுநத்தொல், (Bureau of Indian Standards – 
BIS) ஌ற்றுக்பகொள்஭ப்஧ட்டுள்஭து.  

 தற்ப஧ொது இந்த கு஫ினடீ்டு ன௅ல஫ னே஦ிபகொட் கு஫ினடீ்டு ன௅ல஫னில் 
இலணந்துயிட்டது. 
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5. கூட்டுக: (அ) -2210 + 1510  (ஆ) 2010 + 2510 

(அ) -2210 + 1510 
22 – ன் இன௉஥ில஬஋ண்: 10110 
15 – ன் இன௉஥ில஬ ஋ண்: 1111 
-22 ஋திர்நல஫ ஋ண் ஋ன்஧தொல் அதற்கொ஦ 2-ன் ஥ிபப்஧ி கொண்க: 
22 – ன் 8 – ஧ிட் இன௉஥ில஬ ஋ண்: 00010110 
22 – ன் 1–ன் ஥ிபப்஧ி:  11101001 
1-ன் ஥ிபப்஧ினேடன் 1-஍க் கூட்ட:        1 
-22 ன் 2-ன் ஥ிபப்஧ி:   11101010 
-22  =  1110 1010 
15 =  0000 1111 

-2210 + 1510 =  1111 1001 
 

(ஆ) 2010 + 2510 

2010 - ன் இன௉஥ில஬஋ண் =  10100 
2510 - ன் இன௉஥ில஬஋ண்  =  11001 
2010 + 2510   =     101101 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. (அ) நிதப்புப் புள்஭ி ஧தின்ந எண்லண, இரு஥ில஬ எண்ணாக 

நாற்றுயதற்கா஦ யமிப௃ல஫கல஭ யியரி. 
(ஆ) (98.46)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்ணாக நாற்றுக. 

நிதப்புப் புள்஭ி ஧தின்ந எண்லண, இரு஥ில஬ எண்ணாக நாற்றுயதற்கா஦ 
யமிப௃ல஫:  
2 ன் பதொடர்ப஧ன௉க்கல் ன௅ல஫லனப் ஧னன்஧டுத்தி பகொடுக்கப்஧ட்ட நிதப்ன௃ப்ன௃ள்஭ி 
஧தின்ந஋ண்லண இன௉஥ில஬ ஋ண்ணொக நொற்஫஬ொம். 
 நிதப்ன௃ப்ன௃ள்஭ி ஧தின்ந ஋ண்லண 2 ஆல் ப஧ன௉க்கி யன௉ம் யிலட நதிப்஧ின் 

ன௅ழு ஋ண் ஧குதிலனத் த஦ினொக கு஫ித்து லயக்க பயண்டும்.  
 நீதன௅ள்஭ நிதப்ன௃ப்ன௃ள்஭ி நதிப்ன௃கல஭ நீண்டும் 2 ஆல் ப஧ன௉க்கி, அதன் 

யிலடநதிப்஧ின் ன௅ழு ஋ண் ஧குதிலனத் த஦ினொக கு஫ித்து லயக்க பயண்டும்.  
 இறுதி நதிப்ன௃ 0 ஋஦ யன௉ம் யலபபனொ அல்஬து பதொடர்ந்து ெி஬ இ஬க்கங்கள் 

யலபபனொ நீண்டும், நீண்டும் பநற்கண்ட ன௅ல஫லன ஧ின்஧ற்஫ பயண்டும். 
 த஦ிபன ஋ழுதி லயக்கப்஧ட்டுள்஭ அல஦த்து 0 நற்றும் 1-கல஭ பந஬ின௉ந்து 

கீமொக ஋ழுதபயண்டும். இதுபய, பகொடுக்கப்஧ட்ட நிதப்ன௃ப்ன௃ள்஭ி ஋ண்ணுக்கு 
஥ிகபொ஦ இன௉஥ில஬஋ண் ஆகும். 

  (98.46)10 க்கு ஥ிகபா஦ இரு஥ில஬ எண்: 
ப௃ழுஎண் ஧குதிலன நாற்றுதல்: (98)10 

 

2   98 

2   49 – 0 

2   24 – 1 

2   12 – 0 

2    6 – 0 

2    3 – 0 

     1 – 1 
 

98 க்கு ஥ிகபா஦ இரு஥ில஬ எண்: 11000102 
 நிதப்புப் புள்஭ி ஧குதிலன நாற்றுதல்: (0.46)10 

KOvz; gFjp 

0.46 x 2 =  0.92   0 

0.92 x 2 =  1.84   1 

0.84 x 2 =  1.68   1 

0.68 x 2 =  1.36   1 

0.36 x 2 =  0.72   0 
 

0.46f;F epfuhd ,Uepiy vz;: (0.01110 . . .)2 
 

(98.46)10 = (1100010. 0111 0. . .)2 
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3. (அ) கூட்டுக: 11010102 + 1011012  

(ஆ) கமிக்க: 11010112 – 1110102 

 அ) கூட்டுக:  1101010 

       101101 

                   10010111  

 
ஆ) கமிக்க:  1101011 

     111010 

     110001 
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஧குதி II. பூ஬ினன் இனற்கணிதம் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. இயற்றுள் ஋து, என்று அல்஬து அதற்கு பநற்஧ட்ட ெநிஞ்லைக஭ில் 
இனங்கும் என௉ அடிப்஧லட நின்஦ணு சுற்஫ொகும்? 
அ) ன௄஬ினன் இனற்கணிதம்  ஆ) யொனில்     

 இ) அடிப்஧லை யானில்கள்  ஈ) தன௉யிக்கப்஧ட்ட யொனில்கள் 
2. இயற்றுள் ஋ந்த யொனில் தன௉க்க தல஬ கீமி ஋ன்று அலமக்கப்஧டுகி஫து? 

அ) AND  ஆ) OR இ) NOT  ஈ) XNOR 
3. A+A=? 

அ) A   ஆ) 0   இ) 1   ஈ) A 
4. NOR யொனில் ஋தன் இலணப்஧ொக உள்஭து? 

அ) NOT(OR)  ஆ) NOT(AND)  இ) NOT(NOT)  ஈ) NOT(NOR) 
5. NAND ப஧ொதுலநயொனில் ஋ன்஧து ------------- யொனில் ஋஦ப்஧டும். 

அ) அடிப்஧லட யொனில்   ஆ) தருயிக்கப்஧ட்ை யானில் 
இ) தன௉க்க யொனில்   ஈ) நின்஦ணு யொனில் 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

அ஬கு I - கணி஦ி அ஫ிப௃கம்  
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. பூ஬ினன் இனற்கணிதம் என்஫ால் என்஦? 

 ன௄஬ினன் இனற்கணிதம் என௉ இ஬க்கயலக கணி஦ினில், இ஬க்க சுற்றுகல஭ 
யடியலநக்கப் ஧னன்஧டுத்தப்஧டும் என௉ கணித எழுக்கநொகும்.  

 இது இ஬க்க சுற்றுக஭ில் உள்஭ உள்஭டீுகள் நற்றும் பய஭ினடீுகல௃க்கு 
இலடபன உள்஭ உ஫லய யியரிக்கி஫து. 
 

2. NAND யானில் – சிறுகு஫ிப்பு எழுதுக. 
 AND யொனி஬ின் பய஭ினடீ்லட NOT யொனிலுக்கு அனுப்஧ி ப஧றும் 

பய஭ினடீ்லடக் பகொண்டு NAND யொனில் பெனற்஧டும்.  
 பகொடுக்கப்஧ட்ட உள்஭டீுகள் அல஦த்தும் 1 ஋஦ில் NAND யொனி஬ின் பய஭ினடீு 0-

ஆகனின௉க்கும், இல்ல஬பனல் இதன் பய஭ினடீு 1-ஆகனின௉க்கும். 
 

NAND யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 
3. XOR யானி஬ின் தநய் ஧ட்டினல் எழுதுக. 

XOR யானி஬ின் தநய் ஧ட்டினல் 
உள்஭டீு பய஭ினடீு 

A B C 
0 0 0 
0 1 1 
1 0 1 
1 1 0 

 

4. ததாைர்யிதிகல஭ எழுதுக. 
ததாைர்யிதி Associative: 

 A + (B + C) = (A + B) + C  
 A. (B. C) = (A. B). C 

 

5. தருயிக்கப்஧ட்ை யானில்கள் என்஫ால் என்஦?  
 அடிப்஧லடயொனில்க஭ொ஦ AND, OR, நற்றும் NOT யொனிக஭ி஬ின௉ந்து 

தன௉யிக்கப்஧ட்ட NAND, NOR, XOR நற்றும் XNOR ப஧ொன்஫ யொனில்கள் 
தன௉யிக்கப்஧ட்ட யொனில்கள் ஋஦ப்஧டும். 
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3 நதிப்த஧ண் யி஦ாக்கள்: 
1. அடிப்஧லையானில்க஭ின் தநய்஧ட்டினல்கல஭ எழுதுக. 

AND, OR நற்றும் NOT யொனில்கள் அடிப்஧லடயொனில்கள் ஆகும். 
AND யானி஬ின் தநய்஧ட்டினல்:        OR யானில் தநய் ஧ட்டினல்: 

 
 

NOT யானி஬ின் தநய் ஧ட்டினல்: 
உள்஭டீு பய஭ினடீு 

A C 
1 0 
0 1 

2. XNOR யானில஬ப் ஧ற்஫ி சிறுகு஫ிப்பு யலபக. 
 XNOR (Exclusive – NOR) யொனில் ஋ன்஧து XOR யொனில் இன௉ந்து யந்த 

பய஭ினடீ்டில஦, தல஬கீமொக நொற்஫ி தன௉ம்.  
 உள்஭டீுகள் ெநம். ஋஦ில் பய஭ினடீு 1-஋஦வும், இல்ல஬பனல் பய஭ினடீு 0-

஋஦வும் இன௉க்கும். 
XNOR யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 
 

3. NAND நற்றும் NOR யானில்கள் ஏன் த஧ாதுலந யானில்கள் 
என்஫லமக்கப்஧டுகின்஫஦? 
 அடிப்஧லடயொனில்க஭ொ஦ AND, OR நற்றும் NOT யொனிகல஭ NAND நற்றும் 

NOR யொனில்கள் னெ஬ம் உன௉யொக்க ன௅டினேம். ஋஦பய இலய 
ப஧ொதுலநயொனில்கள் (Universal gates) ஋ன்஫லமக்கப்஧டும். 
 

4. டிநார்கன் மதற்஫ங்கல஭ எழுதுக. 
டிநாபகன் யிதிகள்:  
 (A + B) = A . B  
 (A . B) = A + B 

 

உள்஭டீு பய஭ினடீு 
A B C 
0 0 0 
0 1 0 
1 0 0 
1 1 1 

உள்஭டீு பய஭ினடீு 
A B C 
0 0 0 
0 1 1 
1 0 1 
1 1 1 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. அடிப்஧லையானில்கல஭ அதன் மகாலய நற்றும் தநய்஧ட்டினலுைன் 

யி஭க்குக. 
AND, OR நற்றும் NOT யொனில்கள் அடிப்஧லடயொனில்கள் ஆகும். 
AND யானில்:  
 இபண்டு அல்஬து அதற்கு பந஬ொ஦ உள்஭டீ்டு ெநிஞ்லெகல஭க் பகொண்டு 

பெனற்஧ட்டு என௉ பய஭ினடீ்டு ெநிஞ்லெகல஭ தன௉ம்.  
 உள்஭டீுகள் அல஦த்தும் 1 ஋ன்஫ நதிப்஧ி஬ின௉ந்தொல் இதன் பய஭ினடீு 1 

஋஦வும் இல்ல஬பன஦ில் 0 ஋஦வும் இன௉க்கும். 
AND யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 
OR யானில்:  
 பகொடுக்கப்஧ட்ட உள்஭டீுக஭ில் என்று அல்஬து இபண்டு உள்஭டீுகல௃ம் 1 

஋஦ில் பய஭ினடீு 1 ஋஦வும் இல்ல஬பன஦ில் பய஭ினடீு 0 ஋஦வும் 
இன௉க்கும். 

OR யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

  
NOT யொனில்: 
 NOT யொனில் தன௉க்க தல஬கீமி ஋஦ அலமக்கப்஧டுகி஫து. இது என௉ 

உள்஭டீ்லட நட்டுபந ஌ற்கும். இது தன௉க்க ஥ில஬லன நொற்றும்.  
NOT யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 
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2. தருயிக்கப்஧ட்ை யானில்கல஭ அதன் மகாலய நற்றும் தநய்஧ட்டினலுைன் 
யி஭க்குக. 
NAND, NOR, XOR நற்றும் XNOR ப஧ொன்஫ யொனில்கள் தன௉யிக்கப்஧ட்ட யொனில்கள் 
஋஦ப்஧டும். 
NAND யானில்: 
 AND யொனி஬ின் பய஭ினடீ்லட NOT யொனிலுக்கு அனுப்஧ி ப஧றும் 

பய஭ினடீ்லடக் பகொண்டு NAND யொனில் பெனற்஧டும்.  
 பகொடுக்கப்஧ட்ட உள்஭டீுகள் அல஦த்தும் 1 ஋஦ில் NAND யொனி஬ின் பய஭ினடீு 0-

ஆகனின௉க்கும், இல்ல஬பனல் இதன் பய஭ினடீு 1-ஆகனின௉க்கும். 
 

NAND யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 

NOR யானில்: 
 NOR யொனில் நின்஦ணு சுற்று, என௉ OR யொனில஬ பதொடர்ந்து என௉ தல஬கீமி 

யொனில஬(NOT யொனில்)  ப஧ொன௉த்தி உன௉யொக்கப்஧டும்.  

 பகொடுக்கப்஧டும் இபண்டு உள்஭டீுகல௃ம் 0 ஋஦ில் 1 ஋ன்஧லத பய஭ினடீொக தன௉ம். 
இல்஬ொயிடில் அதன் பய஭ினடீு 0 ஆகும்.  

NOR யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்:: 

 
XOR யானில்: 
 XOR ஋ன்஧து (Exclusive OR) யொனில், இது தன௉க்க “either/OR” ஋ன்஧து ப஧ொ஬பய 

பெனல்஧டும்.  

 உள்஭டீுக஭ின் நதிப்ன௃ பயவ்பய஫ொக இன௉ந்தொல், பய஭ினடீு 1-ஆகனின௉க்கும் 

அல்஬து உள்஭டீுகள் எபப நதிப்஧ி஬ின௉ந்தொல் பய஭ினடீு 0-ஆகும்.  

XOR யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 



 

J. Kavitha, B.Sc, B.Ed, M.C.A, M.Phil., Computer Instructor Gr-I, GHSS, S.S.KULAM - CBE 20 

 

XNOR யானில்: 
 XNOR (Exclusive – NOR) யொனில் ஋ன்஧து XOR யொனில் இன௉ந்து யந்த 

பய஭ினடீ்டில஦, தல஬கீமொக நொற்஫ி தன௉ம்.  
 உள்஭டீுகள் ெநம். ஋஦ில் பய஭ினடீு 1-஋஦வும், இல்ல஬பனல் பய஭ினடீு 0-

஋஦வும் இன௉க்கும். 
XNOR யானி஬ின் தருக்ககு஫ினீடு நற்றும் தநய் ஧ட்டினல்: 

 
 

3. NAND நற்றும் NOR யானில்க஭ின் ப௄஬ம் AND நற்றும் OR யானில்கல஭ 
எவ்யாறு அ஫ியிப்஧ாய் என்஧லத யி஭க்குக. 
NAND யொனில்கல஭ பகொண்டு என௉ OR யொனில஬ கீழ்கண்டயொறு அலநக்க஬ொம். 

 
NOR யொனில்கல஭ பகொண்டு என௉ AND யொனில஬ கீழ்கண்டயொறு அலநக்க஬ொம். 
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஧ாைம் 3. கணி஦ி அலநப்பு 

சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 
1. ஧ின்யன௉ய஦யற்றுள் ஋து கணிப஧ொ஫ினின் னெல஭ ஋஦ அலமக்கப்டுகிி்஫து?  

(அ) உள்஭டீ்டுச் ெொத஦ஙகள் (ஆ) பய஭ினடீ்டுச் ெொத஦ஙகள்  
(இ) ஥ில஦யக சாத஦ஙகள் (ஈ) நுண்பென஬ி 

2. ஧ின்யன௉ய஦யற்றுள் ஋து நுண்பென஬ினின் ஧ொகம் அ஬஬?  
(அ) கணித ஌பணச்பென஬கம்  (ஆ) கட்டுப்஧ொட்டகம்      
(இ) மகச் ஥ில஦யகம்   (ஈ) ஧திபயடு  

3. ஋த்தல஦ ஧ிட்டுகள் என௉ பயர்லட கட்டலநக்கும்?  
(அ) 8     (ஆ) 16     (இ) 32  (ஈ) ஧னன்஧டுத்தும் தசன஬ிலன த஧ாருத்தது  

4. ஧ின்யன௉ம் ஋ந்த ெொத஦ம், ஥ில஦யக ன௅கயரி ஧திபயட்டில் ன௅கயரிலனக் 
கு஫ிக்கும் ப஧ொது அதன் இன௉ப்஧ிடத்லத அலடனொ஭ம் கொட்டும் ?  
(அ) ப஬ொபகட்டர்(Locator) (ஆ) ஋ன்பகொடர்(Encoder)  
(இ) டிமகாைர்(Decoder)  (ஈ) நல்டி ஃ஧ி஭க்ெர்(Multiplexer) 

5. ஧ின்யன௉ய஦ற்றுள் ஋து என௉ CISC பென஬ி ஆகும்?  
(அ) Intel P6   (ஆ) AMD K6   (இ) Pentium III  (ஈ) Pentium IV 

6. ஋து பயகநொக பெனல்஧டும் ஥ில஦யகம் ஆகும்?  
(அ) யன் யட்டு  (ஆ) ன௅தன்லந ஥ில஦யகம்  
(இ) மகச் ஥ில஦யகம்  (ஈ) ன௃ல௃- பப ஥ில஦யகம் 

7. என௉ 8 – ஧ிட் ஥ில஦யக ஧ொட்லட உள்஭ பென஬ி ஋த்தல஦ ஥ில஦யக இடங்கல஭ 
அலடனொ஭ம் கொணும்?  
(அ) 28  (ஆ) 1024  (இ) 256  (ஈ) 8000 

8. எற்ல஫ ஧க்க நற்றும் எற்ல஫ அடுக்கு 12 பெ.நீ யிட்டம் உள்஭ DVD-னின் பநொத்த 
பகொள்஭஭வு ஋வ்ய஭வு?  
(அ) 4.7 GB  (ஆ) 5.5 GB  (இ) 7.8GB  (ஈ) 2.2 GB  

9. CD னின் குல஫ந்த அ஭யி஬ொ஦ தபயின் அ஭வு னொது ?  
(அ) பதொகுதி  (ஆ) ஧குதி  (இ) ஧ிட்ஸ்   (ஈ) தடங்கள் 

10. கணிப்ப஧ொ஫ினின் திலபச்ெொத஦த்லத இலணக்க உதவும் பதொடர்ன௃ ெொத஦ம் ஋து?  
(அ) USB  (ஆ) Ps/2   (இ) SCSI   (ஈ) VGA 

 
 
 
 
 
 
 
 

அ஬கு I - கணி஦ி அ஫ிப௃கம்  
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஒரு த௃ண்தசன஬ினின் ஧ண்புகல஭க் கு஫ிக்கும் காபணிகள் னாலய? 

 கடிகொப பயகம் (Clock Speed)  
 கட்டல஭ பதொகுப்ன௃ (Instruction Set) 
 பயர்டு அ஭வு (Word Size) 

2. அ஫ிவுறுத்தல் என்஫ால் என்஦? 
 என௉ தபயின் நீது பெனல்஧ொடுகல஭ச் பெனல்஧டுத்துயதற்கொக கணிப்ப஧ொ஫ிக்கு 

பகொடுக்கப்஧டும் கட்டல஭கப஭ அ஫ிவுறுத்தல் ஋஦ப்஧டும். 
3. ஥ிபல்கவுண்ட்ைர் என்஫ால் என்஦? 

 ஥ிப஬ின் அடுத்து பெனற்஧டுத்த பயண்டின கட்டல஭னின் ன௅கயரிலன 
லநனச்பென஬கத்தில் பெநித்து லயக்கும் என௉ ெி஫ப்ன௃ ஧திபயடு தொன் ஥ிபல் 
஧திபயடு ஋஦ப்஧டும்.  

4. உனர்யலபனல஫ ஧ல்லூைக இலைப௃கம் (HDMI) என்஫ால் என்஦? 
 உனர் யலபனல஫ ஧ல்லூடக இலடன௅கம் ஋ன்஧து எ஭ிக்கொட்ெி 

கட்டுப்஧டுத்தினி஬ின௉ந்து யன௉ம் சுன௉க்கப்஧டொத  எ஬ி / எ஭ி தபவுகல஭ 
கணிப்ப஧ொ஫ி திலபனகம், LCD ன௃பபொஜக்டர், டிஜிட்டல் பதொல஬க்கொட்ெிக்கு 
பகொடுக்கப் ஧னன்஧டும் என௉ எ஬ி / எ஭ி இலடன௅கம் ஆகும். 

5. EPROM – ல் உள்஭ தபலய எவ்யாறு அமிப்஧ாய்? 
 EPROM – ல் தகயல்கள் ன௃஫ஊதொஎ஭ி பெலுத்தும் யலப பெநித்து 

லயக்கப்஧டுகின்஫஦. ன௃஫ஊதொ எ஭ிலன பெலுத்தி PROM-ன் உள்஭டக்கத்லத 
அமித்து, நீண்டும் பயறு ஥ிபல்கல஭ ஋ழுத஬ொம். 
 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. கணிப்த஧ா஫ி அலநப்பு, கணிப்த஧ா஫ி கட்ைலநப்பு மயறு஧டுத்துக. 

கணிப்த஧ா஫ி அலநப்பு கணிப்த஧ா஫ி கட்ைலநப்பு 
கணிப்ப஧ொ஫ி அலநப்ன௃ ஋ன்஧து 

கணி஦ினின் யன்ப஧ொன௉ள் கூறுகல஭ 

உள்஭டக்கினது. இது ஥ிப஬ன௉க்கு 

யன்ப஧ொன௉ள் கூறுகல஭ 

பய஭ிப்஧லடனொக யி஭க்குகி஫து. 

கணிப்ப஧ொ஫ி கட்டலநப்ன௃  ஋ன்஧து 
கணிப்ப஧ொ஫ிலன யடியலநப்஧தில் 
ஈடு஧ட்டின௉க்கும் ப஧ொ஫ினினல் 
கன௉துபகொல஭  உள்஭டக்கினது. 

2. தபயின் அ஭லயப் த஧ாறுத்து த௃ண்தசன஬ிலன யலகப்஧டுத்துக. 
பென஬ொக்கப்஧டும் தபயின் அக஬த்லத ப஧ொறுத்து நுண்பென஬ிலன 
யலகப்஧டுத்த஬ொம். 
 8 - ஧ிட் நுண்பென஬ி  *   16 - ஧ிட் நுண்பென஬ி 
 32 - ஧ிட் நுண்பென஬ி  *   64 - ஧ிட் நுண்பென஬ி 

3. கட்ைல஭னின் ததாகுதினின் அடிப்஧லைனில் த௃ண்தசன஬ினின் யலககல஭ 
எழுதுக. 
கட்டல஭க஭ின் பதொகுதி அடிப்஧லடனில் நுண்பென஬ிலன இன௉ 
யலகப்஧டுத்த஬ொம். 
1. குல஫க்கப்஧ட்ட கட்டல஭ பதொகுதி கணி஦ிகள் (RISC) 
2. ெிக்க஬ொ஦ கட்டல஭ அலநக்கப்஧ட்ட கணி஦ிகள் (CISC)  
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4. PROM நற்றும் EPROM மயறு஧டுத்துக. 
PROM EPROM 

இது என௉ அமினொ ஥ில஦யகம் 
ஆகும்.  

இது என௉ PROM யலகனொ஦ ெி஫ப்ன௃ 
஥ில஦யகம் ஆகும்.  

இதில் தபவுகள் என௉ ன௅ல஫ 
நட்டுபந ஋ழுத ன௅டினேம். PROM – ல் 
என௉ ன௅ல஫ ஥ிபல்கள் 
஋ழுதியிட்டொல் ஋ப்ப஧ொழுதும் 
அமினொந஬ின௉க்கும். 
 

EPROM – ல் தகயல்கள் ன௃஫ஊதொஎ஭ி 
பெலுத்தும் யலப பெநித்து 
லயக்கப்஧டுகின்஫஦. EPROM – ல் ன௃஫ஊதொ 
எ஭ிலன பெலுத்தி PROM-ன் உள்஭டக்கத்லத 
அமித்து, நீண்டும் பயறு ஥ிபல்கல஭ 
஋ழுத஬ொம். 

5. கணிப்த஧ா஫ினில் ஧னன்஧டுத்தப்஧டும் இலைப௃கம் நற்றும் 
ததாைர்புப௃கங்கல஭ எழுதுக. 
 பதொடர் பதொடர்ன௃ ன௅கம் *   இலணனொ஦ பதொடர்ன௃ ன௅கம்  
 USB பதொடர்ன௃ ன௅கம்   *   USB 3.0  
 VGA இலணப்஧ொன்  *   ஆடிபனொ ஧ி஭க்ஸ்  
 PS/2 Port     *   SCSI Port  
 உனர் யலபனல஫ ஧ல்லூடக இலடன௅கம் (HDMI) 

6. CD நற்றும் DVD மயறு஧டுத்துக. 
CD DVD 

CD ஋஦ப்டும் CD-ROM 1.2 நில்஬ிநீட்டர் 
஧ன௉நன் அ஭யில் ஧ொ஬ிகொர்஧ப஦ட் 
஧ி஭ொஸ்டிக் ப஧ொன௉஭ொல் ஆ஦தொகும்.  

இது கண்ணொடினிலம யட்டு ஆகும்.  

பநல்஬ின அ஭யி஬ொ஦ அலுநி஦ினம் 
அ஬஬து தங்க ன௅஬ொம் அதன் 
பநல்஧குதினில் ன௄ெப்஧ட்டின௉க்கும். 

இவ்யலக யட்டு என்று அ஬஬து 
இபண்டு ஧க்கங்கல஭க் பகொண்டு, 
பநலும் என௉ ஧க்கத்திற்கு என்று 
அ஬஬து இபணடு அடுக்குக஭ில் 
இன௉க்கும். இன௉ அடுக்கு DVD தங்க 
஥ி஫த்திலும் என௉ அடுக்கு DVD பயள்஭ி 
஥ி஫த்திலும் கிலடக்கும். 

CD - ன் பகொள்஭஭வு 700 MB ஆகும். இது 4.7 GB யலப தபவுல஭ பெநிக்கும். 
7. ஃ஧ி஭ாஷ் ஥ில஦யகம் நற்றும் EEPROM எவ்யாறு மயறு஧டுத்துயாய்? 

ஃ஧ி஭ாஷ் ஥ில஦யகம் EEPROM 
ஃ஧ி஭ொஷ் ஥ில஦யகம் என௉ நின்஦னு 

அமிவு஫ொத பெநிக்கும் ெொத஦நொகும். 

பநலும் நின்ெொபத்தின் னெ஬ம் ஥ிபல்கல஭ 

அமித்து, நறு஧டினேம் ஥ிப஬ொக்க ன௅டினேம். 

என௉ ெி஫ப்ன௃ PROM யலகலன ெொர்ந்த  
஥ில஦யகம் ஆகும். இதில் உள்஭ 
தபவுகல஭ நின்ெொபத்லதச் பெலுத்திபன 
அமிக்க஬ொம் 

பயகநொ஦ அணுகல் ப஥பத்லத 
யமங்குகி஫து. 

EEPROM பநதுயொக இனங்கும் 
஥ில஦யகம் ஆகும். 
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. த௃ண்தசன஬ினின் ஧ண்பு கூறுகல஭ யி஭க்குக. 

என௉ நுண்பென஬ினின் பெனல்஧ொடு, கீழ்கொணும்  ஧ண்஧ினல்ன௃கல஭ 
அடிப்஧லடனொகக் பகொண்டது. 

 கடிகொப பயகம் (Clock Speed)  
 கட்டல஭ பதொகுப்ன௃ (Instruction Set) 
 பயர்டு அ஭வு (Word Size) 

கடிகாப மயகம்:  
 எவ்பயொன௉ நுண்பென஬ினிலும் உள்ப஭ என௉ கடிகொபம் உள்஭து.  
 கணிப்ப஧ொ஫ினின் எவ்பயொன௉ கட்டல஭னேம் ஥ில஫பயற்றுத஬ின் பயகத்லத 

இந்தக் கடிகொபம் கட்டுப்஧டுத்துகி஫து. இதுபய கடிகொபத்தின் பயகம் ஋஦ப்஧டும். 
 கணிப்ப஧ொ஫ினின் பயகம் பநகொபெர்ட்ஸ் (Mega Hertz) நற்றும் ஜிகொபெர்ட்ஸ் 

(Giga Hertz) அ஭யில் அ஭க்கப்஧டுகி஫து. 
கட்ைல஭ ததாகுப்பு :  
 நுண்பென஬ிலன பெனல்஧டுத்துயதற்கொக யடியலநக்கப்஧ட்ட அடிப்஧லட 

இனந்திப ஥ில஬ அ஫ிவுறுத்தல் பதொகுதிகல஭க் கட்டல஭த்பதொகுப்ன௃ 
஋ன்கிப஫ொம்.  

 இந்த கட்டல஭க஭ின் பதொகுதி ஧ின்யன௉ம் பெனல்கல஭ பெனல்஧டுத்துகி஫து. 
 தபவு நொற்஫ம் 
 ஋ண்கணித பெனல்ன௅ல஫கள் 
 தன௉க்கபெனல்ன௅ல஫கள் 
 கட்டுப்஧ொட்டு ஥கர்வு 
 உள்஭டீு / பய஭ினடீு 

மயர்டு அ஭வு : 
 என௉ பயர்டு அ஭வு ஋ன்஧து  என௉ தடலய பென஬ி பெனல்஧டுத்தும் 

஧ிட்டுக஭ின் அ஭யொகும். 
 என௉ பயர்டு அ஭வு ஋ன்஧து கணிப்ப஧ொ஫ினின் ன௅தன்லந ஥ில஦யகம் (RAM) 

பெனற்஧டுத்தும் கட்டல஭னின் அ஭லயனேம், நுண்பென஬ினில் உள்஭ 
ஊெிக஭ின் (Pins) ஋ண்ணிக்லகலனனேம் ப஧ொறுத்ததொகும்.  

 உள்஭டீு நற்றும் பய஭ினடீு ஊெிக஭ின் பநொத்த ஋ண்ணிக்லக நுண்பென஬ினின் 
கட்டலநப்ல஧ தீர்நொ஦ிக்கி஫து. 

2. ஧டித்தல்/ எழுதுதல் (READ / WRITE) தசனல்கல஭ தசன஬ி எவ்யாறு தசய்கி஫து? 
யி஭க்குக. 
 ஧டித்தல் (READ) பெனல்஧ொடு தபவுகல஭ (஧ிட்டுகல஭) பயர்டில் இன௉ந்து 

஥ில஦யக தபவு ஧திபயடுகல௃க்கு அனுப்ன௃ம்.  
 ஋ழுதுதல் (WRITE) பெனல்஧ொடு தபவுகல஭ (஧ிட்டுகல஭) ஥ில஦யக தபவு 

஧திபயடுக஭ில்இன௉ந்து பயர்டிற்கு அனுப்ன௃ம். 
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3. இனக்கம஥பத்தின் அடிப்஧லைனில் ஥ில஦யக சாத஦ங்கல஭ ஏறுயரிலசனில் 

அலநக்கவும். 
஧஬ யலகனொக ஥ில஦யகச் ெொத஦ங்கள், அதன் பகொள்஭஭வு, பயகம் நற்றும் 
யில஬னின் அடிப்஧லடனில் யரிலெப்஧டுத்தப்஧ட்டுள்஭து. 

 
 

4. ROM ன் யலககல஭ப்஧ற்஫ி யி஭க்கநாக எழுதுக 
஧டிக்கநட்டும் ஥ில஦யகம் (ROM - Read-Only Memory): 
 கணிப்ப஧ொ஫ினின்  ெி஫ப்ன௃ ஥ில஦யகம் ஆகும். 
 ROM – ல் கணி஦ிலனத் துயங்குயதற்கொ஦ நிக ன௅க்கின ஥ிபல்கள் பெநித்து 

லயக்கப்஧டுகின்஫஦. இதில் என௉ ன௅ல஫ தபவுகல஭ ஋ழுதி யிட்டொல் அலத 
நொற்஫பயொ அல்஬து அமிக்கபயொ ன௅டினொது. ஆ஦ொல் ஧டிக்க நட்டும் ன௅டினேம். 

 ROM – ன் உள்஭டக்கம் நின்ெொபம் ஥ிறுத்தப்஧ட்டொலும் அமியதில்ல஬, இத஦ொல் 
ROM அமினொ ஥ில஦யகம் ஋஦ அலமக்கப்஧டுகி஫து. 

஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் (PROM):  
 ஥ிப஬ொக்கு ஧டிக்கநட்டும் ஥ில஦யகம் என௉ அமினொ ஥ில஦யகம் ஆகும். 
 இதில் தபவுகள் என௉ ன௅ல஫ நட்டுபந ஋ழுத ன௅டினேம். PROM – ல் என௉ ன௅ல஫ 

஥ிபல்கள் ஋ழுதியிட்டொல் ஋ப்ப஧ொழுதும் அமினொந஬ின௉க்கும். 
அமிக்கக்கூடின ஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் (EPROM):  
 இது என௉ PROM யலகனொ஦ ெி஫ப்ன௃ ஥ில஦யகம் ஆகும்.  
 EPROM – ல் ன௃஫ஊதொ எ஭ிலன பெலுத்தி PROM-ன் உள்஭டக்கத்லத அமித்து, 

நீண்டும் பயறு ஥ிபல்கல஭ ஋ழுத஬ொம். 
 EPROM ப஧ொதுயொக த஦ினொள் கணிப்ப஧ொ஫ினில் ஧னன்஧டுத்தப்஧டுகி஫து. 
நின்சாபத்தால் அமிக்கும் நற்றும் ஥ிப஬ாக்கு ஧டிக்கநட்டும் ஥ில஦யகம் 
(EEPROM):  
 என௉ ெி஫ப்ன௃ PROM யலகலன ெொர்ந்த  ஥ில஦யகம் ஆகும்.  
 இதில் உள்஭ தபவுகல஭ நின்ெொபத்லதச் பெலுத்திபன அமிக்க஬ொம் 
 EEPROM பநதுயொக இனங்கும் ஥ில஦யகம் ஆகும். 
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஧ாைம் 4. இனக்க அலநப்஧ின் மகாட்஧ாட்டுக் கருத்துக்கள் 
சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 

1. இனக்க அலநப்஧ொ஦து ------------------  
அ) ஧னன்஧ொட்டு பநன்ப஧ொன௉ள்  ஆ) யன்ப஧ொன௉ள்  
இ) அலநப்பு தநன்த஧ாருள்  ஈ) உ஧கபணம்  

2. இனக்க அலநப்ன௃க஭ின் ஧னன்஧ொட்லட கண்ட஫ினவும்  
அ) ந஦ித நற்றும் கணி஦ி இலடபன ஋஭ிதொக பதொடர்ன௃  
ஆ) உள்஭டீு நற்றும் பய஭ினடீு ெொத஦ங்கள் கட்டுப்஧டுத்தும்  
இ) ன௅தன்லந ஥ில஦யகத்லத பந஬ொண்லந பெய்ன  
ஈ) இலய அல஦த்தும்  

3. ஧ின்யன௉ம் ஋து, இனக்க அலநப்ன௃ பெனல்஧ொடு அல்஬?  
அ) பெனல்ன௅ல஫ பந஬ொண்லந  ஆ) ஥ில஦யக பந஬ொண்லந  
இ) ஧ொதுகொப்ன௃ பந஬ொண்லந  ஈ) ஥ிபல் த஧னர்ப்஧ி சூமல்  

4. ஧ின்யன௉ம் ஋ந்த இனக்க அலநப்ன௃ யணிக ரீதினொக உரிநம் ப஧ற்஫ இனக்க 
அலநப்ன௃ ஆகும்?  
அ) யிண்மைாஸ்  ஆ) உன௃ண்டு   இ) ப஧படொபபொ  ஈ) பபட்பெட்  

5. ஧ின்யன௉ம் இனக்க அலநப்ன௃க஭ில் பநொல஧ல் ெொத஦ங்கல஭ ஆதரிப்஧து ஋து?  
அ) யிண்படொஸ் 7   ஆ) ஬ி஦க்ஸ்  இ) ஧ொஸ்  ஈ) iOS  

6. பகொப்ன௃ பந஬ொண்லந ஋யற்ல஫ ஥ிர்யகிக்கி஫து ?  
அ) பகொப்ன௃கள்ஆ) பகொப்ன௃ல஫கள் இ) அலடவு அலநப்ன௃கள் ஈ) இலயஅல஦த்தும் 

7. ஊடொடு இனக்க அலநப்ன௃ யமங்கும் யெதி.  
அ) யலபகல஬ ஧ன஦ர் இலைப௃கம் (GUI) ஆ) தபவு யி஥ிபனொகம்  
இ) ஧ொதுகொப்ன௃ பந஬ொண்லந  ஈ) உண்லநனொ஦ ப஥பம் பென஬ொக்க 

8. எற்ல஫ ஧ன஦ர் இனக்க அலநப்஧ிற்கு ஋டுத்துக்கொட்டு  
அ) ஬ி஦க்ஸ்  ஆ) யிண்படொஸ்  இ) MS DOS   ஈ) னே஦ிக்ஸ் 

9. ஬ி஦க்ஸ் ஋ந்தயலக பகொப்ன௃ பந஬ொண்லநலன ஧னன்஧டுத்துகி஫து  
அ) ext2  ஆ) NTFS  இ) FAT  ஈ) NFTS 
 

 
 
 
 
 
 
 
 
 
 

அ஬கு I - கணி஦ி அ஫ிப௃கம்  
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஥ில஦யக மந஬ாண்லநனின் ஥ன்லநகள் ஏமதனும் இபண்லை கூறு ? 

 லநன பென஬கத்தின் ஧னன்஧ொட்லட பநம்஧டுத்துதல், 
 ன௅தன்லந ஥ில஦யகத்தின் யமினொக கணிப்ப஧ொ஫ினின் பயகத்லத 

அதிகப்஧டுத்துதல் 
2. ஧஬ ஧ன஦ர் இனக்க அலநப்பு என்஫ால் என்஦? 

 எபப ப஥பத்தில் என்றுக்கும் பநற்஧ட்ட ஧ன஦ர்கள், எபப நொதிரினொ஦ 
தபவுகல஭னேம் ஧னன்஧ொடுகல஭னேம் கணிப்ப஧ொ஫ினில் ஧னன்஧டுத்த 
அனுநதிக்கும் இனக்க அலநப்ன௃ “஧஬ ஧ன஦ர் இனக்க அலநப்ன௃” ஋஦ப்஧டும். 
஋.கொ: Windows, Unix, Linux 

3. GUI என்஫ால் என்஦? 
 யலபகல஬ ஧ன஦ர் இலடன௅கம் (GUI) ென்஦ல் திலப அடிப்஧லடனி஬ொ஦, 

ப஥படினொக உள்஭டீ்டு / பய஭ினடீுகல஭ லகனொள்யதற்கும், ஧ட்டிக஭ி஬ின௉ந்து 
பதர்வு பெய்யதற்கும், பதர்ந்பதடுப்஧தற்கு பதலயனொ஦ சுட்டும் கன௉யிகல஭க் 
(Pointing devices) பகொண்டது. 

 யலபகல஬ ஧ன஦ர் இலடன௅கத்தின் கயன௉ம் யண்ணங்கள், ஧ன஦லப ஋஭ிதொக 
ஈர்க்கின்஫து. 

4. ஧ாதுகாப்பு மந஬ாண்லநனின் ஥ன்லநகள் னாலய? 
இனக்க அலநப்ன௃ ஧ன஦ன௉க்கு னென்று ஥ில஬ப் ஧ொதுகொப்ல஧ யமங்குகி஫து. 

1. பகொப்ன௃ ஥ில஬ 
2. அலநப்ன௃ ஥ில஬ 
3. யல஬ ஥ில஬ 

5. கணிப்த஧ா஫ினில் ஧னன்஧டுத்தப்஧டும் தயவ்மயறு இனக்க அலநப்புகள் 
னாலய? 
 னை஦ிக்ஸ் 
 லநக்பபொெொஃப்ட் யிண்படொஸ் 
 ஬ி஦க்ஸ் 
 Mac OS 
 MS - DOS 

 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. ம஥பம் ஧கிர்தல் இனக்க அலநப்஧ின் ஥ன்லநகள் நற்றும் தலீநகள் என்஦?  

஥ன்லநகள்: 
 எபப ப஥பத்தில் ஧஬ ஧ணிகல஭ அல்஬து பெனல்கல஭ பெனல்஧டுத்துகி஫து. 
 எவ்பயொன௉ ஧ணிக்கும் என௉ கு஫ிப்஧ிட்ட ப஥பம் எதுக்கீடு பெய்னப்஧டுயதொல் 

஋ந்த ஧ணிக்கும் தலட ஌ற்஧டுயதில்ல஬. 
தலீநகள்: 
 ப஥பப்஧கிர்வுக்கு அதிக ய஭ங்கள் பதலயப்஧டுயதொல், உனர்தி஫ன் நிக்க 

யன்ப஧ொன௉ள் ெொத஦ங்கள் பதலய. 
 அதிப்஧டினொ஦ ஧ணிகல஭ அல்஬து ஧னன்஧ொடுகல஭ இனக்கும் ப஧ொது, ெி஬ 

ப஥பங்க஭ில் கணி஦ி பெனல் இமக்க ப஥ரிடும். 
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2. இனக்க அலநப்஧ின் ப௃க்கின சி஫ப்஧ினல்புகல஭ ஧ட்டின஬ிடுக. 
 ஧ன஦ர் இலடன௅கம் 
 பகொப்ன௃ பந஬ொண்லந 
 ஥ில஦யக பந஬ொண்லந 
 ஧ிலம ப஧ொறுப்ன௃ 
 பெனல் பந஬ொண்லந 
 ஧ொதுகொப்ன௃ பந஬ொண்லந 

3. ஧஬ தசன஬ாக்க இனக்க அலநப்பு சிறு கு஫ிப்பு யலபக. 
 ஧஬ பென஬ொக்க பெனல்ன௅ல஫ இபண்டு அல்஬து அதற்கு பநற்஧ட்ட 

பென஬ிகல஭க் பகொண்டுள்஭து. பென஬ொக்கம் இலணனொக பெனல்஧டுயதொல் 
இது இலணனொக்க பென஬ி ஆகும்.  

 எவ்பயொன௉ பென஬ொக்கன௅ம் எபப பயல஬னில் பயவ்பயறு ஧குதிக஭ில் 
அல்஬து இபண்டு அல்஬து அதற்கு பநற்஧ட்ட பயவ்பயறு ஧ணிகல஭ 
பெய்கி஫து.  

 ஧஬ பெனல்கள் இலணனொக ஥ில஫பயற்஫ப்஧டுயதொல், இந்த அம்ெநொ஦து 
அதிக஧ட்ெ இனக்கத்திற்கு ஧னன்஧டுத்தப்஧டுகி஫து. இது கணி஦ிப்஧ணினின் 
தி஫ல஦ பநம்஧டுத்துகி஫து. 

5 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஧பயல் இனக்க அலநப்஧ின் கருத்துரு ஧ற்஫ி யி஭க்குக. மநலும் அதன் 

஧னன்஧ாடுகள் னாலய? 
 டிஜிட்டல் இலணனம் யமினொக உ஬பகங்கிலும் ஧஬ இடங்க஭ில் 

பெநிக்கப்஧ட்டு பென஬ொக்கப்஧ட்ட தபவுகள் நற்றும் ஧னன்஧ொட்டுகல஭ இந்த 
அம்ெம் கய஦ித்து பகொள்கி஫து. 

஧பயல் இனக்க அலநப்஧ின் ஥ன்லநகள்: 
 எபப இடத்தில் உள்஭ என௉ ஧ன஦ர், யல஬னலநப்஧ின் னெ஬ம் நற்ப஫ொன௉ 

இடத்திலுள்஭ ஋ல்஬ொ ய஭ங்கல஭னேம் ஧னன்஧டுத்த஬ொம். 
 ஧஬ கணி஦ி ய஭ங்கல஭ யல஬னலநப்஧ில் ஋஭ிதொக இலணக்க ன௅டினேம் 
 யொடிக்லகனொ஭ர்கல௃டன் உள்஭ பதொடர்ன௃கல஭ பநம்஧டுத்துகி஫து. 
 ன௃பய஬ர் (Host) கணி஦ினில் உள்஭ சுலநலனக் குல஫க்கி஫து 

2. ஒரு இனக்க ப௃ல஫லநக்கா஦ ஧ன஦ர் இலைப௃கத்லத உருயாக்கும் ம஧ாது 
கய஦த்தில் தகாள்஭ மயண்டின ப௃க்கின கருத்துக்கல஭ ஧ட்டின஬ிடுக. 
 ஧ன஦ர் இலடன௅கநொ஦து, ஥ீண்டகொ஬த்திற்கு ஧னன்஧ொட்டில் இன௉க்க பயண்டும்.  
 இலடன௅கம் ஧ன஦ரின் பதலயகல஭த் தின௉ப்தி பெய்னபயண்டும். 
 ஧ன஦ர் இலடன௅கநொ஦து, ஧ன஦ரின் யில஬நதிப்஧ற்஫ ப஥பத்லதபெநிக்கி஫து. 

யலபகல஬கூறுக஭ொ஦ ஧ட்டிகள், ென்஦ல் திலபகள், தத்தல், ஧ணிக்கு஫ிகள் நற்றும் 
தட்டச்சு பெய்னேம் பயல஬லனக் குல஫த்தல் ப஧ொன்஫லய இனக்க அலநப்஧ின் 
கூடுதல் ஧ன஦ொகும். 

 ஋ந்த என௉ தனொரிப்஧ின் உனரின ப஥ொக்கன௅ம், யொடிக்லகனொ஭லபத் தின௉ப்திப்஧டுத்த 
பயண்டும் ஋ன்஧தொகும். அபதப஧ொல், ஧ன஦ர் இலடன௅கன௅ம் யொடிக்லகனொ஭லபத் 
தின௉ப்திப்஧டுத்துநொறு யடியலநக்கப்஧டபயண்டும் 

 ஧ன஦ர் பெய்னேம் தயறுகல஭ இலடன௅கம் குல஫க்க பயண்டும். அபதப஧ொல் ஧ன஦ர் 
குல஫ந்த஧னிற்ெினிலும், தயறுகல஭த் தயிர்க்கும் யண்ணம் இன௉த்தல் பயண்டும்.  
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3. இனக்க அலநப்஧ின் தசனல் மந஬ாண்லந த஥஫ிப௃ல஫கல஭ யி஭க்குக. 
என௉ கணிப்ப஧ொ஫ினின் பென஬கத்திற்குத் பதலயனொ஦ பெனல்ன௅ல஫கல஭ 
எதுக்கீடு பெய்யதற்கு கீழ்க்கொணும் ப஥஫ின௅ல஫கள் (Algorithms) ன௅தன்லநனொகப் 
஧ின்஧ற்஫ப்஧டுகின்஫து. 

1. ன௅த஬ில் யந்த து ன௅த஬ில் பெல்லும் (FIFO) 
2. ெி஫ினது ன௅த஬ில் (Shortest Job First) 
3. யட்ட யரிலெ (Round Robin) 
4. ன௅ன்னுரிலநக்கு ஌ற்஧ (Based on Priority) 

 ப௃த஬ில் யந்தது ப௃த஬ில் தசல்லும் (FIFO - First In First Out): 
ன௅த஬ில் யந்தது ன௅த஬ில் பெல்லும் ப஥஫ின௅ல஫, யரிலெ நுட்஧த்லத 
அடிப்஧லடனொகக் பகொண்டது.  
஋.கொ: நுட்஧ ரீதினொக, யரிலெனில் ன௅த஬ில் நுலமனேம் பெனல்ன௅ல஫ ன௅த஬ில் 
CPU-யில் பெனல்஧டுத்தப்஧ட்டு, அடுத்தடுத்து யரிலெனொக 
பெனல்஧டுத்தப்஧டுகின்஫஦. 

 சி஫ினது ப௃த஬ில் (Shortest Job First): 
இந்த ப஥஫ின௅ல஫, லநனச் பென஬கத்தொல் இனக்கப்஧டும் என௉ பயல஬னின் 
அ஭லய அடிப்஧லடனொகக் பகொண்டது.  
எ.கா: A நற்றும் B ஋஦ இபண்டு பயல஬கல஭ ஋டுத்துக்பகொள்பயொம். இதில், 
A பயல஬னின் அ஭வு 6KB நற்றும் B பயல஬னின் அ஭வு 9 KB. இந்த இபண்டு 
பயல஬க஭ில், A பயல஬னின் அ஭வு, B பயல஬லன யிடகுல஫யொக 
இன௉ப்஧தொல், ன௅த஬ில் A பயல஬ இனக்கப்஧டும். 

 யட்ை யரிலச திட்ைநிைல் (Round Robin): 
யட்ட யரிலெ திட்டநிடல் “ப஥பப் ஧கிர்வு அலநப்ன௃”-கல௃க்கு (Time Sharing 
System) ெி஫ப்஧ொக யடியலநக்கப்஧ட்ட ப஥஫ின௅ல஫ ஆகும். சுமற்ெி ன௅ல஫னில், 
எவ்பயொன௉ ஧ணிக்கும், என௉ கு஫ிப்஧ிட்ட ப஥பம் எதுக்கப்஧டும்.  
஋.கொ: A, B, C ஋஦ னென்று பயல஬கள் இன௉ப்஧தொக ஋டுத்துக்பகொள்பயொம். 
இதில், ன௅த஬ொயது A ஧ின்஦ர் B அலத பதொடர்ந்து C ஋஦ எவ்பயொன௉ 
பயல஬க்கும் என௉ கு஫ிப்஧ிட்ட ப஥பம் சுமற்ெி ன௅ல஫னில் லநனச் 
பென஬கத்தொல் எதுக்கப்஧டும். நீண்டும் அடுத்த சுமற்ெினில் யட்டயரிலெ 
ன௅ல஫னில் பயல஬ எதுக்கீடு பெய்னப்஧டும். 

 ப௃ன்னுரிலநக்கு ஏற்஧ (Based on Priority): 
பகொடுக்கப்஧ட்ட பயல஬ ன௅ன்னுரிலந அடிப்஧லடனில் எதுக்கப்஧ட்டுள்஭து. 
நற்஫ பயல஬கல஭ யிட அதிக ன௅ன்னுரிலந பகொண்டின௉க்கும் பயல஬ 
நிகவும் ன௅க்கினநொ஦து. 
஋.கொ: இபண்டு பயல஬கள் A நற்றும் B ஋஦ ஋டுத்துக்பகொள்பயொம். A-க்கு 
ன௅ன்னுரிலந ஋ண் 5 ஋஦வும், B-க்கு 7 ஋஦வும் இன௉ந்தொல், ன௅த஬ில் B-
க்குதொன் பென஬கம் எதுக்கப்஧டும். 
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஧ாைம் 5 . யிண்மைாஸ் - ல் மயல஬ தசய்தல் 

சரினா஦ யிலைலன மதர்ந்ததடுத்து எழுதுக: 
1. கீபம பகொடுக்கப்஧ட்டுள்஭யற்றுள் இனக்கஅலநப்ன௃ ஥ிர்யகிக்கும் பெனல்கல஭த் 

பதர்வு பெய்னவும்  
(அ) ஥ில஦யகம் (ஆ) பென஬ி (இ) I/O ெொத஦ங்கள் (ஈ) இலயஅல஦த்தும் 

2 யிண்படொஸ் ஧னன்஧ொட்டில் பகொப்ன௃கள் பகொடொ஥ில஬னொக ஋ந்த பகொப்ன௃ல஫னில் 
பெநிக்கப்஧டும்?  
(அ) My document (ஆ) My Picture (இ) Document and settings  (ஈ) My Computer 

3 ஋ந்த இனக்கலநப்஧ில் shift + delete ஋ன்஫ பதர்வு பகொப்ன௃ நற்றும் பகொப்ன௃ல஫லன 
஥ிபந்தபநொக ஥ீக்கும்?  
(அ) windows 7 (ஆ) windows 8 (இ) windows 10 (ஈ) இலயஅல஦த்தும் 

4 Windows XP/Windows 7 ல் “லெ஧ர்ப஦ட்”஋ன்஧தன் ப஧ொன௉ள் ஋ன்஦?  
அ) Safe mode ல் கணி஦ிலன நறுபதொடக்கம் பெய்தல்.  
ஆ) hibernate mode ல் கணி஦ிலன ஥ிறுத்துதல்.  
இ) இனக்கத்தில் இன௉க்கும் ஧னன்஧ொடுகல஭ ஥ிறுத்தின ஧ி஫கு கணி஦ிலன 
஥ிறுத்துதல்.  
ஈ) இனக்கத்தில் இருக்கும் ஧னன்஧ாடுகல஭ ஥ிறுத்தாநல் கணி஦ிலன 
஥ிறுத்துதல். 

5 ெொ஭பங்க஭ில் என௉ பகொப்஧ின் நறுப஧னரிட ஧னன்஧டுத்தப்஧டும் குறுக்குயமி யிலெ 
(அ) F2  (ஆ) F4  (இ) F5  (ஈ) F6 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

அ஬கு I - கணி஦ி அ஫ிப௃கம்  
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2 நதிப்த஧ண் யி஦ாக்கள்: 
1. ஧ல்஧ணினாக்கம் என்஫ால் என்஦ ? 

 யிண்படொஸ் - ல் எபப ப஥பத்தில் என்றுக்கும் பநற்஧ட்ட ஧னன்஧ொடுகல஭ 
இனகக ன௅டினேம் இதற்கு “஧ல்஧ணினொக்கம்” (Multitasking) ஋ன்று ப஧னர். 

2. தசந்தப஧ணிக்கு஫ி என்஫ால் என்஦ ? 
 யிண்படொஸ் இனக்க அலநப்ன௃ ஥ிறுயப்஧டும் ப஧ொது உன௉யொக்கப்஧டும் 

பகொடொ஥ில஬ ஧ணிக்கு஫ிகள், "பெந்தப஧ணிக்கு஫ிகள்" ஋஦ அலமக்கப்டுகிி்஫து.  
஋.கொ: MyComputer, Documents நற்றும் Recycle Bin ப஧ொன்஫லய.  

3. மகாப்பு நற்றும் மகாப்புல஫க்கு உள்஭ யித்தினாசங்கள் னாலய? 
மகாப்பு மகாப்புல஫ 

கணிப்ப஧ொ஫ினில் அல஦த்து 
தகயல்கல௃ம் பகொப்ன௃க஭ொக 
பெநிக்கப்஧டுகி஫து. 

பகொப்ன௃கல஭ என௉ங்கலநக்க 
பகொப்ன௃ல஫கள் ஧னன்஧டுகி஫து. 

4. Save நற்றும் Save As - க்கு உள்஭ யித்தினாசங்கள் னாலய? 
Save Save As 

என௉ பகொப்ல஧ ன௅தன்ன௅த஬ில் 
கணிப்ப஧ொ஫ினில் பெநிக்க Save  
கட்டல஭ ஧னன்஧டுகி஫து. 

஌ற்க஦பய பெநிக்கப்஧ட்ட பகொப்ல஧ 
பயப஫ொன௉ ப஧னரில் பெநிக்க Save As 
கட்டல஭ ஧னன்஧டுகி஫து. 

5. ஒரு மகாப்ல஧ எவ்யாறு நறுத஧னரிடுயரீ்கள்? 
நறுப஧னரிட பயண்டின பகொப்ல஧ பதர்வு பெய்து,  
 File -> Rename ஋ன்஫ ஧ட்டிப்஧ட்லட பதர்யின் னெ஬ன௅ம், 
 பகொப்஧ின் நீது ய஬து கி஭ிக் பெய்து யன௉ம் ஧ட்டின஬ில் Rename ஋ன்஫ பதர்லய 

கி஭ிக் பெய்யதன் னெ஬ன௅ம், 
 யிலெப்஧஬லகனில் உள்஭ F2 ப஧ொத்தொல஦ அழுத்துயதன் னெ஬ன௅ம் 

நறுப஧னரிட஬ொம். 
 

3 நதிப்த஧ண் யி஦ாக்கள்: 
1. யிண்மைாஸ் இனக்கஅலநப்஧ின் தசனல்஧ாடுகள் னாலய? 

 பெொற்பென஬ிகள், அட்டயலணச்பென஬ிகள், கணிப்஧ொன், யில஭னொட்டுகள் 
ப஧ொன்஫ ஧னன்஧ொடுல஭ இனக்குகி஫து. 

 கணிப்ப஧ொ஫ினில் ன௃தின ஧னன்஧ொடுல஭ ஥ிறுவுயதற்கு ஧னன்஧டுகி஫து. 
 அச்சுப்ப஧ொ஫ி, யன௉டி, சுட்டி, இ஬க்கயலக பகநபொ ப஧ொன்஫ யன்ப஧ொன௉ள்கல஭ 

பந஬ொண்லந பெய்கி஫து. 
 பகொப்ன௃ ந஫றும் பகொப்ன௃ல஫கள் உன௉யொக்குதல், ஧திப்஧ொய்வு பெய்தல், 

பெநித்தல், அமித்தல் ப஧ொன்஫ பகொப்ன௃ பந஬ொண்லந பெனல்஧ொடுகல஭ 
பெய்கி஫து. 
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2. நறுசுமற்சி த஧ட்டிலன ஧ற்஫ி ஒரு கு஫ிப்பு யலபக. 
 நறுசுமற்ெி பதொட்டி ஋ன்஧து, ஧ன஦பொல் ஥ீக்கப்஧ட்ட பகொப்ன௃ அல்஬து 

பகொப்ன௃ல஫கல஭, தற்கொ஬ிகநொக பெநித்து லயக்க ஧னன்஧டும் ெி஫ப்ன௃ 
பகொப்ன௃ல஫னொகும்.  

 அமிக்கப்஧ட்ட பகொப்ன௃கல஭ நீட்படடுக்க இது நீண்டும் என௉ யொய்ப்ல஧ 
யமங்குகி஫து.  

 நறுசுமற்ெித் பதொட்டினிலுள்஭ பகொப்ன௃கள் நற்றும் பகொப்ன௃ல஫கல஭ 
நீட்படடுக்கொநல் இனக்க ன௅டினொது. 
 

3. யிண்மைாஸ் சன்஦ல் திலபக்கூறுகல஭ப் ஧ற்஫ி கு஫ிப்பு யலபக. 
 தல஬ப்புப்஧ட்லை: தி஫ந்துள்஭ஆயணத்தின் ப஧னர் அல்஬து ஧னன்஧ொட்டின் 

ப஧னர் தல஬ப்ன௃ப் ஧ட்லடனில் பதொன்றும்.  பநலும் ெி஫ிதொக்கு, ப஧ரினதொக்கு நற்றும் 

னெடு ப஧ொத்தொன்கல௃ம் தல஬ப்ன௃ ஧ட்லடனில் உள்஭஦.  

 ஧ட்டிப்஧ட்லை: தல஬ப்ன௃ ஧ட்லடனின் கீழ் ன௃஫ம் ஧ட்டிப்஧ட்லட கொணப்஧டும்.  
 ஧ணித்த஭ம்: என௉ ஆயணத்தில் உலபலனத் தட்டச்சு பெய்னேம் ஆயண ென்஦ல் 

திலபனின் ஧குதி ஧ணித்த஭ம் ஆகும்.  
 உரு஭ல் ஧ட்லை: உன௉஭ல் ஧ட்லடகள் ஧ணித்த஭த்லதச் பெங்குத்தொகவும், 

கிலடநட்டநொகவும் உன௉஭ பெய்னப் ஧னன்஧டுகி஫து 
 ப௄ல஬கள் நற்றும் எல்ல஬கள்: யிண்படொஸில் அ஭லய நொற்஫ி அலநக்க 

னெல஬ நற்றும்  ஋ல்ல஬ உதயி  பெய்கி஫து. 

4. ஒரு மகாப்புலபலன உருயாக்கும் இபண்டு யமிப௃ல஫கல஭ எழுதுக. 
யமிப௃ல஫ 1: 
 கம்ப்னைட்டர் குறும்஧டத்லத கி஭ிக் பெய்து, ன௃தின பகொப்ன௃ல஫லன உன௉யொக்க 

யின௉ம்ன௃ம் இனக்கிலன தி஫க்கவும்.  
 File → New → Folder ஋ன்஧லத கி஭ிக் பெய்தொல் ன௃தின பகொப்ன௃ல஫, தொ஦லநயொக 

“New Folder” ஋஦ உன௉யொகும். 
யமிப௃ல஫ 2: 
 திலபன௅கப்஧ில் நற்றும் பதலயனொ஦ இடத்தில் சுட்டினின் ய஬து 

ப஧ொத்தொல஦க் கி஭ிக்பெய்து, New → Folder ஋ன்஫ கட்டல஭லனக் கி஭ிக் 
பெய்தொல் ப஧னரிடப்஧டொத new folder பகொப்ன௃ல஫ பதொன்றும்.  

 

5. தயட்டுதல் நற்றும் ஥கத஬டுத்தல்- க்கு உள்஭ மயறு஧ாடுகள் னாலய? 
தயட்டுதல் ஥கத஬டுத்தல் 

பகொப்ன௃ அல்஬து பகொப்ன௃ல஫கல஭ னெ஬ 
இடத்தி஬ின௉ந்து ன௃தின இடத்திற்கு 
஥கர்த்துதல் பயட்டுதல் ஋஦ப்஧டும். 

பகொப்ன௃ அல்஬து பகொப்ன௃ல஫க஭ின் 
஧ிபதிலன ன௃தின இடத்திற்கு ஥கர்த்துதல் 
஥கப஬டுத்தல் ஋஦ப்஧டும். 

னெ஬க் பகொப்ன௃கள் அமிக்கப்஧டும். னெ஬க் பகொப்ன௃கள் 
அமிக்கப்஧டுயதில்ல஬. 

கட்டல஭: Edit → Cut (or) Ctrl + X 
         Edit → Paste (or) Ctrl + V          

கட்டல஭: Edit → Copy (or) Ctrl + C 
         Edit → Paste (or) Ctrl + V          
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5 நதிப்த஧ண் யி஦ாக்கள்: 
1. யிண்மைாஸ் இனக்கஅலநப்஧ின் ஧஬யலகனா஦ ஧திப்புகல஭ யியரி. 

஧திப்புகள் ஆண்டு ப௃க்கின சி஫ப்஧ினல்புகள் 
யிண்மைாஸ் 1.x 1985  16 ஧ிட்டுக஭ில் யலபகல஬ ஧ன஦ர் இலடன௅கம் 

அ஫ின௅கம் பெய்னப்஧ட்டது. 
 உள்஭டீ்டு ெொத஦நொக சுட்டி அ஫ின௅கநொ஦து. 

யிண்மைாஸ் 2.x 1987  ென்஦ல் திலபலன ெி஫ிதொக்குதல் அல்஬து 
ப஧ரிதொக்குதல் யெதி. 

 கட்டுப்஧ொட்டகம் அ஫ின௅கம் பெய்னப்஧ட்டது. 
யிண்மைாஸ் 3.x 1992 

 
 “஧ல்஧ணி கன௉த்துன௉” அ஫ின௅கநொ஦து. 
 256 யண்ணங்கல஭ இனக்கும் தி஫ப஦ொடு 

நிக஥ய஦ீ யண்ணநனநொ஦து. 
யிண்மைாஸ் 95 1995  பதொடக்க ப஧ொத்தொன், பதொடக்கப்஧ட்டி, 

஧ணிப்஧ட்லட, யிண்படொஸ் ஋க்ஸ்ப்ப஭ொபர் 
அ஫ின௅கநொ஦து. 

 32஧ிட் நுண்பென஬ி அ஫ின௅கநொ஦து. 
யிண்மைாஸ் 98 1998 

 
 Internet Explorer ஋ன்னும் உ஬யி அ஫ின௅கநொ஦து. 
 யிண்படொஸ் அடிப்஧லடனி஬ொ஦ 

யில஭னொட்டுகள் பநம்஧டுத்தப்஧ட்டது. 
யிண்மைாஸ் NT 
 

  யல஬னலநப்஧ில் பெலயனகநொக 
யடியலநக்கப்஧ட்டது. 

யிண்படொஸ் 2000 2000  ஥ொன்கு ஧திப்ன௃கள் பய஭ினிடப்஧ட்ட஦. 
யிண்மைாஸ் XP 2001  64-஧ிட் நுண்பென஬ிகள் அ஫ின௅கம். 

 யிண்படொஸ் பதொற்஫ம் நற்றும் ஧ணித்த஭ம் 
பநம்஧டுத்தப்஧ட்டது. 

யிண்மைாஸ் 7 2009  கணிப்ப஧ொ஫ினின் பதொடங்குதல் ப஥பம் 
பநம்஧டுத்தப்஧ட்டது. 

 ஌பபொ ஧கீ், ஧ணிப்ப்லடனில் ஧னன்஧ொடுகல஭ 
இலணத்தல், லகபனழுத்து உணர்தல், 
இன்டர்ப஥ட் ஋க்ஸ்ப்ப஭ொபர் 8 ப஧ொன்஫ ன௃தின 
஧ன஦ர் இலடன௅க யெதிகள் 
அ஫ின௅கப்஧டுத்தப்஧ட்டது. 

யிண்மைாஜ் 8 2012  ஧ல் அடுக்கு நுண்பென஬ி, பதொடுதிலப, நொற்று 
உள்஭டீ்டு ன௅ல஫கள் ப஧ொன்஫ ெி஫ப்஧ம்ெங்கள் 
பெர்க்கப்஧ட்டது. 

 லகப஧ெி நற்றும் கணிப்ப஧ொ஫ிகல௃க்கொ஦ 
ப஧ொதுயொ஦ ஧ணிபநலடனொக பெனல்஧டுகி஫து. 

யிண்மைாஸ் 10 2015  என்றுக்கும் பநற்஧ட்ட திலப ன௅கப்ன௃. 
 “பென஬ி அ஫ியிப்ன௃” நற்றும் “யிலபவு 

஥டயடிக்லக பென஬ிக்கொ஦ நத்தின அ஫ியிப்ன௃ 
லநனம்” அ஫ின௅கம். 
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2. ஒரு மகாப்பு அல்஬து மகாப்புலபலன மதடிக்கண்டு஧ிடிக்கும் ஧ல்மயறு 
யமிப௃ல஫கல஭ யி஭க்குக.  
கணி஦ினில் அல்஬து கு஫ிப்஧ிட்ட இனக்கிக஭ில் உள்஭ பகொப்ன௃ அல்஬து 
பகொப்ன௃ல஫லன யிலபயொக பதடுயதற்கு பதொடக்கப் ப஧ொத்தொ஦ிலுள்஭ Search 
ப஧ட்டி ஧னன்஧டுத்தப்஧டுகி஫து. 
மகாப்பு அல்஬து மகாப்புல஫லனக் கண்டு஧ிடிக்க, 
 Start ப஧ொத்தொல஦ கி஭ிக் பெய்தொல், பதொடக்கப஧ட்டினின் கலடெினில் Search 

ப஧ட்டி கொணப்஧டும். 
 அதில், பதடப்஧ட பயண்டின பகொப்ன௃ அல்஬து பகொப்ன௃ல஫னின் ப஧னலப 

தட்டச்சு பெய்ன பயண்டும். 
 கு஫ிப்஧ிடப்஧ட்ட ப஧னரிலுள்஭ பகொப்ன௃ அல்஬து பகொப்ன௃ல஫கள் திலபனில் 

பதொன்றும். அதல஦ கி஭ிக்பெய்தொல், பகொப்ன௃ ப஥படினொக தி஫க்கும். 
 Search ப஧ட்டிக்கு பநப஬ “See more results” ஋ன்஫ நற்ப஫ொன௉ பதர்வும் உள்஭து. 
 இந்த பதர்லயக் கி஭ிக்பெய்னேம் ப஧ொது, Search Results உலபனொடல் ப஧ட்டி 

பதொன்றும். இதன் னெ஬ன௅ம், பகொப்ன௃ அல்஬து பகொப்ன௃ல஫கல஭ பதடி 
தி஫க்க஬ொம். 
 

3. யிண்மைாஸ் இனக்க அலநப்஧ில் குறுக்கு யமி ஧ணிக்கு஫ிகல஭ 
உருயாக்கும் தசனல் ப௃ல஫லன யி஭க்குக.  
 ஥நது பயல஬லனத் தொ஦ினங்கினொக நொற்றுயதற்கு ஥நக்கு அடிக்கடி 

஧னன்஧டும் பகொப்ன௃கள் நற்றும் பகொப்ன௃ல஫க஭ின் குறுக்கு யமிகல஭ 
உன௉யொக்கி, அலத ன௅கப்ன௃த்திலபனில் லயக்க஬ொம்.  

 ன௅த஬ில் பகொப்ன௃ அல்஬து பகொப்ன௃ல஫லன பதர்வு பெய்து, அதன் நீது ய஬து 
கி஭ிக் பெய்ன பயண்டும். 

 அப்ப஧ொழுது என௉ பநல்நீட்ன௃ப் ஧ட்டி பதொன்றும். அதி஬ின௉ந்து Send to → Desktop 
(Create Shortcut) ஋ன்஫ பதர்லய கி஭ிக்பெய்தொல் யிண்படொஸ் திலபன௅கப்஧ில், 
பகொப்ன௃ அல்஬து பகொப்ன௃ல஫னின் குறுக்குயமி ஧ணிக்கு஫ி பதொன்றும்.  
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யாழ்க்லகனில் இன்஫ினலநனாது 
கல்யி நட்டுமந.. 

அத்தலகன கல்யிலன த஧ற்று 
யாழ்க்லகனில் மநலும் மநலும் ய஭ப 

யாழ்த்துக்கள்! 
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